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Disclaimer

Vizrt provides this publication “as is” without warranty of any kind, either expressed or
implied. his publication may contain technical inaccuracies or typographical errors. While every
precaution has been taken in the preparation of this document to ensure that it contains
accurate and up-to-date information, the publisher and author assume no responsibility for
errors or omissions. Nor is any liability assumed for damages resulting from the use of the
information contained in this document. Vizrt’s policy is one of continual development, so the content of this 
document is periodically subject to be modified without notice. These changes will be incorporated in new editions 
of the publication. Vizrt may make improvements and/or changes in the product(s) and/or the program(s) 
described in this publication at any time.
Vizrt may have patents or pending patent applications covering subject matters in this
document. The furnishing of this document does not give you any license to these patents.

Antivirus Considerations

Vizrt advises customers to use an AV solution that allows for custom exclusions and granular performance tuning to 
prevent unnecessary interference with our products. If interference is encountered:

Real-Time Scanning: Keep it enabled, but exclude any performance-sensitive operations involving Vizrt-
specific folders, files, and processes. For example:

C:\Program Files\[Product Name]
C:\ProgramData\[Product Name]
Any custom directory where [Product Name] stores data, and any specific process related to [Product 
Name].

Risk Acknowledgment: Excluding certain folders/processes may improve performance, but also create an 
attack vector.
Scan Scheduling: Run full system scans during off-peak hours.
False Positives: If behavior-based detection flags a false positive, mark that executable as a trusted 
application.

Technical Support

For technical support and the latest news of upgrades, documentation, and related products,
visit the Vizrt web site at www.vizrt.com.
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1 Introduction
This guide is intended for those who have little or no experience in using Viz World, and aims to help new users 
become familiar with the system.

1.1 Related Documents
For additional information, see the following documents:

Viz World Classic User Guide: Contains information on how to create map templates using Viz World Classic.
Viz World Plug-ins Guide: Contains information on how to use the Viz World plug-ins.
Viz Artist User Guide: Contains information on how to create graphics scenes and animations in Viz Artist.
Viz Engine Administrator Guide: Contains information on how to install the Viz Engine software and 
supported hardware. Viz Engine is the output engine used for playout of graphics, video, images, SDI sound 
and sound effects.
Viz Trio User Guide: Contains information on how to create real-time character generated content based on 
templates and how to play out pages in shows based on these templates.
Viz Pilot User Guide: Contains information on how to create content based on templates and how to play out 
elements in playlists based on these templates.
Viz Multichannel User Guide: Describes how to install, configure and use Viz Multichannel.
Viz NLE Administrator Guide: Contains information on how to use your graphics in a non-linear editing tool.

For more information about all of the Vizrt products, visit:

www.vizrt.com
Vizrt Documentation Center
Vizrt Training Center
Vizrt Forum

1.2 Feedback and Suggestions
We encourage suggestions and feedback about our products and documentation. To give feedback and/or 
suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

See Also

About Viz World

http://docs.vizrt.com/viz-world.html
http://docs.vizrt.com/viz-world.html
http://docs.vizrt.com/viz-artist.html
http://docs.vizrt.com/viz-engine.html
http://docs.vizrt.com/viz-trio.html
http://docs.vizrt.com/viz-pilot.html
http://docs.vizrt.com/viz-multichannel.html
http://docs.vizrt.com/viz-nle.html
http://www.vizrt.com/
http://documentation.vizrt.com/
http://www.vizrt.com/training/
http://forum.vizrt.com/
http://www.vizrt.com/
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2 About Viz World
For many years Viz World Classic (formerly called Viz Curious Maps) was the broadcast industry’s number one tool 
for the creation of branded 2D maps and geographic animations.

Now Viz World takes this to a new level by adding support for real-time 3D maps and adding the option to extend it 
to a client-server solution.

Viz World takes branded map imagery and provides it to different clients that are embedded within Vizrt’s control 
applications like Viz Trio and Viz Pilot. Templates created within Viz World can also be accessed by Viz Artist and 
even NLE systems.

This tight integration allows users to seamlessly create branded, animated maps and add them to graphic 
templates or insert them directly into a 3D scene. In addition, high-resolution satellite imagery from around the 
world can instantly be browsed, downloaded, and incorporated.

Viz World Client (WoC) integrates Viz World’s mapping ability and database into Viz Artist and Viz Engine graphics. 
By utilizing a set of geographic referencing plug-ins and the maps produced by WoC, the creation of location based 
graphics using maps, 3D objects, texts, and so on, is seamless.

WoC includes a set of Viz Artist plug-ins and the World Map Editor (WME). The editor is integrated into Vizrt 
products, simplifying production and control of the graphics.

The WoC also includes the Map Designer for creating map templates on-the-fly, as well as the Map Builder for 
creating animated scenes with single or multiple destinations.

Usage of WoC clients requires one or more Viz World Servers (WoS) installed, running, and connected to the 
network. WoS is a software module used for creating template-based maps and managing client requests. All the 
map styles, map projects and designs are stored on the server. The server’s license determines the number of 
concurrent client connections and the available data sets.

This section contains information on the following topics:

Workflow
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2.

3.

4.
5.

2.1 Workflow
The basic workflow from the design of templates to playout is as follow:

The first step of the process is to create a single (or multiple) in-house map project templates that set the 
look and feel of all the produced maps later in the production chain. This is done using Viz World Classic 
(VWC), selecting for example style and color on the selected map area, type of borderlines, label fonts, and 
available marker icons.
The designed map project template is made available to users of Vizrt client software via the Viz World 
Server (WoS).
A graphic designer creates Viz scenes that include maps, based on the same map project template now 
residing on the Viz World Server. The designer has the option to create 2D or 3D labels and markers inside 
Viz, instead of using the ones exposed in Viz World Classic.
Based on the Viz scenes, graphical templates can be made for other Vizrt applications.
An editor opens a template, from for example the Viz Pilot, and creates a map to fit the main news of today.
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3 Requirements
This section describes the prerequisites such as the licensing, software and hardware requirements.

This section contains information on the following topics:

License Requirements
Software Compatibility
Server System Requirements
Ports and Connections

See Also

Installation
Configuration
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3.1 License Requirements
The following licenses are needed to run Viz World Server and Viz Engine:

A USB dongle license for Viz World Server.
A USB dongle license for Viz Engine.

If you are using the old green Sentinel dongles, please update your Sentinel Super Pro drivers to the latest version. If 
you are using the Aladdin dongles (usually blue), please install the Aladdin Hard Lock driver.

Aladdin dongle driver is available in the Installers folder in the installation directory, which is usually in the 
following default path:

32-bit: C:\Program Files (x86)\vizrt\Viz World\Installers
64-bit: C:\Program Files\vizrt\Viz World\Installers

Note: Viz World Server is a feature included in the license file. If the server has additional features enabled, 
make sure the new license file covers those features as well.
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3.2 Software Compatibility
To run the Viz World Client and Server, the following software is required:

Viz World Client (Map Editor) version 24.0.
Viz World Server 24.0 (It is recommended to install the server on a separate machine).

Viz World database version 24.0. 

Microsoft Visual C++ 2010 Redistributable Package.
Microsoft Visual C++ 2019 Redistributable Package.
Microsoft .NET Framework 4 or later is required for the Map Designer, Map Builder, and World Map Editor.

Viz World 24.0.0 was tested with:

Viz Engine 5.3.2
Viz Engine 4.4.1
Viz Engine 3.14.5
Viz Pilot 8.9.3
Viz Pilot Edge 3.2.0
Viz Pilot Data Server 9.0.0
Viz Trio 4.2.0

Note: Installing Viz World server and Viz World client on separate machines is recommended.

Note: Viz World database is recommended to be installed on the same machine as Viz World Server for 
easier configurations.

Note: Running any of the installers version 24.0 installs all the required software listed above which should 
not be uninstalled. 
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3.3 Server System Requirements

Component Minimum Configuration Recommended Configuration

CPU Eight cores with 2.4 GHz 
frequency

2 x Intel i7 CPU (or equivalent Intel Xeon 
processor)

Memory 8 GB 16 GB

Disk Space A full installation requires at least 2 GB of available disk space.

Optional data packages require between 4 GB to 1000 GB of available disk space.

Operating 
System

Microsoft Windows 10
Microsoft Windows Server 2019

Network A redundant (teamed) setup with two Gigabit network adapters is recommended.

Power Supply A redundant power supply is highly recommended.

Note: Viz World Server and Viz World Classic will not function while 
connected using Windows Remote Desktop.

Note: When more than one server runs on a single machine, it is necessary to use the recommended 
system configuration described above. See Server Allocator Configuration.
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3.4 Ports and Connections
The following describes all connections and default listening port numbers that are important for any system/
network administrator to know of. However, it is recommended to run the system on a network without firewalls if 
possible.

Port Proto
col

Description

102 TCP Viz World Server listener port for Viz World Client connections when Server 
Allocator is not in use or only has one Viz World Server running.

103 TCP Viz World Server listener port for configuration tool connections to the first Viz 
World Server instance (as configurations are controlled by the first server 
instance).

1010

0

TCP Server Allocator listener port for Viz World Client connections, and is only used 
in order for clients to get connection details about Viz World Server(s).

The first client connection is always diverted to port 102 . In case of Multiple 

Server Instances, port numbers are assigned according to a predefined 
schema. In case there is no Server Allocator, Viz World Server switches to port 

102 .

1010

0

UDP Viz World Server listener port for Server Allocator communication.

1020

0

UDP Server Allocator listener port for Viz World Server communication.

1030

0

HTTP Viz World Server listener port for Server Allocator communication.

Both UDP ports are internal ports used between the servers.

3.4.1 Multiple Server Instances
If a machine is running multiple Viz World Server instances every extra instance (second and above) opens other 
ports by this formula:

Viz World Server listener port (TCP): 10100 + ID – 1.
Server Allocator listener port (UDP): 10200 + ID – 1 (this is an internal port between servers) (where ID 
indicates the instance, for example the third server, ID = 3).
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Server Allocator listener port (HTTP): 10300 + ID – 1 (this is an internal port between servers) (where ID 
indicates the instance, for example the third server, ID = 3).

If four Viz World Server instances are configured, the following listener ports are used:

102 (TCP): First instance.
10101 (TCP): Second instance.
10102 (TCP): Third instance.
10103 (TCP): Fourth instance.
10100 (TCP): Viz World Client(s) connection to the Server Allocator.
103 (TCP): Configuration tool connection to the Viz World Server.

Internal ports used by Server Allocator and Viz World Server(s) to communicate between themselves:

10100 (UDP): Server Allocator.
10200 (UDP): First instance.
10201 (UDP): Second instance.
10202 (UDP): Third instance.
10203 (UDP): Fourth instance.
10301 (HTTP): First instance.
10302 (HTTP): Second instance.
10303 (HTTP): Third instance.
10304 (HTTP): Fourth instance.
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4 Installation
This section describes how to install and remove the components of Viz World Server (WoS) and Viz World Client 
(WoC).

This section contains information on the following topics:

Downloading the Software
Installing Viz World Client
Installing Viz World Server
Installing the Photoshop Plug-in
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4.1 Downloading the Software
Whilst you have an active map support contract, you have a personal login to the Vizrt FTP server (first year support 
is included).

Download the software from the Vizrt FTP at ftp://download.vizrt.com/ under the Viz World folder.

Please use the FTP server to find the latest Vizrt software releases, documentation, help files, drivers and more. You 
can also use the FTP to upload and exchange files with Vizrt.

Note: You need to use an FTP Client to access this site and not a regular web browser.

ftp://download.vizrt.com/
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4.2 Installing Viz World Client
Viz World Client (WoC) is used to integrate maps and geographical data into scenes. Its components are Map 
Designer, Map Builder, World Map Editor, Map Editor Classic. For Viz Engine Map plug-ins see the separate Viz 
Engine Maps plug-in installer.

Viz World Client (WoC) installs new components in the following place:

C:\Program Files\vizrt\common

Select the installer settings that correspond to your Viz Engine (32-bit or 64-bit). Use the bundle installer (which 
includes both 32-bit and 64-bit) for easier installation of Viz Trio/Viz Pilot/Viz Weather clients when combined with a 
64-bit Viz Engine.

There are two ways of installing the client:

Standard installation: that requires the user to perform and confirm all actions during the installation.
Silent installation: that enables the user to install Viz World Client without using the installer’s dialog 
boxes.

This section contains information on the following topics:

To Install Viz World Client
To Install Viz World Client in Silent Mode

Viz World Client 64-bit Silent Install
To Uninstall Viz World Client in Silent Mode
To Remove Viz World Client

4.2.1 To Install Viz World Client
Double-click the VizWorldClient_x.x.x.msi installer to start the installation.
In the Setup Type window, select Typical, and click Next.
Select the Yes, I want to restart my computer now option.
Click Finish.

4.2.2 To Install Viz World Client in Silent Mode

Viz World Client 64-bit Silent Install

Command: msiexec /i <path to Viz World Client installer file> /passive  (This 
installs Viz World Client 64-bit including the design client, help files and API files to C:\Program 
Files\Vizrt\Common)
Example: msiexec /i C:\VizWorldClient_x64_24.0.0.14934.msi /passive

Command: msiexec /i <path to Viz World Client installer file> /passive 

ADDLOCAL=ALL  (This installs Viz World client 64-bit including all client files (Design-Admin-Traffic), help 

Note: Viz World Client may run in a virtualized environment.
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files and API files to C:\Program Files\Vizrt\Common\Maps).
Example: msiexec /i C:\VizWorldClient_x64_24.0.0.14934.msi /passive 

ADDLOCAL=ALL

Command: msiexec /i <path to Viz World Client installer file> /passive 

ADDLOCAL=ALL REMOVE=Admin  (This installs Viz World client 64-bit including client files (Design-
Traffic), help files and API files to C:\Program Files\Vizrt\Common\Maps). 
Example: msiexec /i C:\VizWorldClient_x64_24.0.0.14934.msi /passive 

ADDLOCAL=ALL REMOVE=Admin

REMOVE key values are:

Design: To not install Map Design Client, Style editor.
Admin: To not install Map config client, World server Monitor, Maps Name Editor, GeoFeeds Configuration, 
CMS Test Client.
Traffic: To not install FetchTraffic and TotalTrafficConfigurator.
H: To not install help files.
A: To not install API files.

4.2.3 To Uninstall Viz World Client in Silent Mode
Viz World Client 64-bit/32-bit silent uninstall: 

Command: msiexec /x <path to Viz World Client installer file> /passive

4.2.4 To Remove Viz World Client
Start the Client installer by either:

Starting Add or Remove Programs and click the Change/Remove button next to the Vizrt Viz World 
Client item, or
Running the VizWorldClient_x.x.x.x.msi installer file.

Select the Remove Installed Files option and click Next.
Click Finish.

IMPORTANT! Any unexpected events during silent installation may result in a failure. Unexpected events 
can be, for example, needing to restart the computer.
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4.3 Installing Viz World Server

The Viz World Data and Viz World Server installers are required. 

This section contains information on the following topics:

To Install Viz World Data
To Install Viz World Server and Classic

4.3.1 To Install Viz World Data
Start the Viz World Data installer VizWorldDb24.0.0.msi.
Click Next.
Select the features to install. Combination and Relief are mandatory features while Extras is optional 
(Extras feature contains UK MapData with Metropolitan counties of England to be imported as street data if 
required).
Click Install to begin the installation.
Click Finish.

4.3.2 To Install Viz World Server and Classic
Before Viz World Classic is installed, you have to install Viz World Data.

Viz World Server and Classic may run in a virtualized environment.

Start the Viz World Server installer VizWorld24.0.0.msi.
Click Next.
Read the End-User license agreement and accept it.
Click Next.
Select destination directory, and click Next. Default installation directories are: 

32-bit: C:\Program Files (x86)\Curious Software\Curious World Maps
64-bit: C:\Program Files\vizrt\Viz World

Click Install to start the installation.
Click Finish.
Optional: Install QuickTime if it is not previously installed. If a newer version of QuickTime is installed the 
installation stops.

Note:  Before starting an installation, ensure that the Viz World Server USB license dongle and license file 
are available. If the license is MAC address based, only a license file is required.

Note: The licensing dongle does not show up when connecting to the machine with Remote Desktop 
(RDP). Instead, use a different remote access technology.

Note: Exit all Windows programs before running the Setup Program.

Tip: If you do not already have QuickTime installed, you can download the installer from the Apple 
website.
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4.4 Installing the Photoshop Plug-in
The Viz World Photoshop Plug-in is used to integrate Viz World and Adobe Photoshop files. Maps created with the 
Photoshop plug-in create a new file with separate layers for every feature and detail on the map.

The scripts which are installed as part of the plug-in are used to:

Configure the different settings of the Photoshop Plug-in.
Open Map Editor Classic to select the desired map.
Create the final Adobe Photoshop file and layers, based on the selection and configuration.

4.4.1 Installed Files
The Photoshop plug-in is installed under:

C:\Program Files\Adobe\Photoshop\Plug-ins\Import-Export or
C:\Program Files (x86)\Adobe\Photoshop\Plug-ins\Import-Export

The file that is installed is:

VizrtMapImport.8ba

The scripts are installed under:

C:\Program Files\Adobe\Photoshop\Presets\Scripts or
C:\Program Files (x86)\Adobe\Photoshop\Presets\Scripts

4.4.2 To Install the Photoshop Plug-in
Install Viz World Client (see Installing Viz World Client).
Double click the VizWorld-Photoshop-xxx.msi.

Click Next.

4.4.3 To Configure the Photoshop Plug-in
Launch Adobe Photoshop.
Click File > Script > Viz World Setting.
Enter the machine name of your Viz World Server.

Important! Newer Versions of Adobe Photoshop (like CC 2017)  install in a different directory than C:
\Program Files\Adobe\Photoshop. It might be required to copy the whole content of C:\Program 
Files\Adobe\Photoshop to the real Photoshop Installation location, usually at something like C:\Program 
Files\Adobe\Adobe Photoshop CC 2017.

Note: To support Adobe Photoshop 32-bit and 64-bit, there are two different installers, (x86 and x64). 
Ensure you have the installer which matches your Photoshop version, also a bundle installer is available 
for installing required dependencies, and provides the option to choose which Photoshop plug-in version 
to install (x86 and x64).
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Info: The configuration file used is located in C:\Program Files\vizrt\Maps\Photoshop if you need to edit the 
configuration manually.
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5 Configuration
This section describes how to configure Viz World Server, Viz Engine, and Viz Artist, as well as some useful cache 
settings.

This section contains information on the following topics:

Viz Artist and Viz Engine Configuration
Server Configuration
Cache Configuration
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5.1 Viz Artist and Viz Engine Configuration
This section contains information on how to configure the Viz Artist Render Engine.

5.1.1 Maps Configuration

Map Server: Enables or disables Viz World Server (WoS) connection for Viz World Client (WoC).
Server: Sets the Viz World Server host.

Project: Sets the default map project that is opened with the client application.
Available: Lists all available Viz World Server projects.
Map size: Sets the default map size to be used with the client application.
Cache: Enables caching of maps for faster preview and fetching of maps. Especially useful for journalists and 
operators using Newsroom Component and Viz Trio respectively.
Cache Directory: Sets the cache directory for cached maps which can be a local drive, mapped drive or a 
Universal Naming Convention (UNC) path.

Memory (Images): Sets the number of images to keep in memory.
On disk (Days): Sets the number of days to save images on disk.

Note: If a Server Allocator is used, it should point to this location.

IMPORTANT! Make sure the Cache Directory folder is configured with read and write access rights.
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2nd Cache Directory: Enables a second cache (see Cache above). The main purpose of the second cache is 
to enable redundancy in those cases where a main cache directory is on a different computer and for some 
reason fails. Another use case is to use it as a local cache to save loading time (for example, if you load all 
borders for the entire world you would have 100MB+ of cached files). In order to shorten load time you can 
copy large static files to the correct local cache folder. In the 3D Map Setting plug-in you also finds a Sync 
Local Cache Folder button which copies all the needed files to your local cache. Note that the second cache 
directory settings can only be used by Viz World version 12.0 and later.
Priority: Sets the machine’s connection priority to the Viz World Server (WoS). Setting a number, where 1

is the lowest and 100  is the highest you may override connection priorities set by other machines. The 
configuration interface allows you to prioritize client connections from Viz Artist and On Air Viz Engines used 
for preview and program output. Viz Engines must be in On Air mode for them to be prioritized. For Viz 
World’s Map Editor you can set it from the Context Menu. To enable this behavior on the server side you 
need to enable WoS to prioritize its connections/logins. If the configuration option is not visible, please read 
how To Add the VizWorld.ini File and set the priority.
Network Monitor: Enables you to monitor relevant network connections (server and cache folders). If you 
do not monitor the network and you try to connect over a “disconnected network”, connecting to a server or 
a UNC path, it takes time before the system reports back (30 seconds or more). Enabling network monitoring 
will avoid such connection issues. Note that the network monitor only monitors a cache folder that use a 
UNC path (not mounted/mapped drives). If the configuration option is not visible, please read how To Add 
the VizWorld.ini File.
Languages: Sets the current language to be used on labels fetched from Viz World Server. For more 
information, see the Display section.
Attributions: Adds an attribution to the map. Alternatives are; Static and Dynamic.

Dynamic: Displays the attribution when a licensed imagery is in view and disappears when the image 
is out of view.
Static: Displays the attribution as long as there is a licensed imagery in the scene.

Attribution Font: Sets the font for the attribution.
Bold: Sets the attribution font to bold.
Italic: Sets the attribution font to italic.
On Top: Places the attribution image to the top in the screen. Default is bottom.
On Right: Places the attribution image to the right in the screen. Default is left.

5.1.2 To Add the VizWorld.ini File
Create a and save a VizWorld.ini file to the following location: C:\ProgramData\vizrt\VizEngine\Maps.
Open the file and enter the following:

Monitor=1 
Priority=1 
Language=[my Language ID]

Save the file and start Viz Config to see the configurable parameters:

Monitor: Enables network monitoring. See the Network Monitor setting, listed above.
Priority: Sets the Viz connection priority to the Viz World Server. See the Priority setting listed above, and 
the Server Launcher Configuration section on how to enable prioritized connections on the server side.
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• my Language ID: Refers to the order of languages in your list of languages (English = 0, Arabic = 1, Hebrew = 
2 and so on). See the Languages setting, listed above.
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5.2 Server Configuration
The Server Configuration Tool is used to remotely configure the Viz World Server settings.

The configuration tool is included when Installing Viz World Server and can also be installed when Installing Viz 
World Client. From the Windows start menu, select:

Server: Programs > Vizrt > Viz World Server > Server Configuration tool
Client: Programs > Vizrt > Viz World Client > Server Configuration tool

This section contains information on the following topics:

User Interface
Template
Locations
Logins
License
Maps
Standalone Clients
Symbols
Timeouts
Proxy Server
Server Logging

Caution: The server is locked when using the configuration tool; hence, no client connections are 
accepted.

Note: When using Server Allocator with multiple servers, each machine running the servers must be 
configured separately. Use the configuration tool to connect to all the servers and configure them.
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5.2.1 User Interface

The server configuration window has two panes, the left pane displays the configuration sections and the right 
pane displays the parameters of the selected section.

Before using the configuration tool, a connection to the server must be established. When a connection is 
established, the Connect button is disabled and the Disconnect button is enabled. The right pane is populated with 
the parameters of the selected section.

When connected, the main configuration window appears as follows:

Send Logoff Message: Sends a logoff request to the server. The server ends the session normally.
Force Logoff: Sends a logoff message to the server, ending the session immediately.
Restart: Restarts the server instantly. The configuration tool is disconnected from the server. When a Map 
Server is defined, and more than one instance of Viz World Server is defined, all instances are restarted.

Note: Most configuration changes require a server restart before they take effect.

Caution: When Viz Maps Server Config tool is running the server is locked. No client connections are 
accepted.
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To Connect to the Server
Enter the server name or IP address in the Map Server field, and click Connect.

5.2.2 Template

Project Template: Defines the default project to be used by the server when initially asking for a map or the 
client requests a project that does not exist.

5.2.3 Locations
The Locations section defines the path to the required software components.

Root: Defines the installation folder.
Licenses: Defines the license file(s) folder.
Settings: Defines the path to the settings folder.

5.2.4 Logins
The Logins > Users section displays the users configured on the server. Viz World Clients use the pre-defined Guest 
user to log on to the server.

The Logins > Guest screen is used to set some of the guest user permissions.

Note: Users are added and removed from Viz World Classic only.
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Allow <user name>: Allows the user to connect to the server when running WME or Viz.
Allow <user name> Projects: Allows the user to access projects defined in the <user name> Project Folder.
<user name> Project Folder: Defines the path to a folder containing the user’s projects.

5.2.5 License

The License section displays information about the current server license and enables the user to load other license 
files.

Add License From File: Opens a file browser that enables the user to load additional license features from a 
different license file and to add it to the system. After a new license file is added, the Apply button is 
enabled.
Dump License Info: Saves the license information, that is displayed in the text box, to a file.
Apply: Applies the new license information to the system’s license file.

To Manually Add a License File
Locate the License file (*.lic), copy and paste it into the Licenses folder:

32-bit: C:\ProgramData\Curious Software\Curious World Maps\Licenses
64-bit: C:\ProgramData\vizrt\Viz World\Licenses

Note: If the license is not valid, the server will not start.



Viz World User Guide -  24.0

Copyright © 2025  Vizrt                                                          Page  34

1.
2.
3.
4.

5.

1.
2.
3.
4.
5.
6.
7.

•
•
•
•
•
•
•

To Add a License File Using the Maps Server Configuration Tool
Start the server configuration tool.
Select the License section.
Click the Add License From File ... button.
Locate and select the file and click Open to add the new license file. The license becomes visible in the Edit 
License window.
Click Restart to start the server with the new license.

To Add a License File Using Viz World Classic

When starting Viz World Classic without a license, a window appears informing that a valid license cannot be found.

Start the Viz World Classic application.
Click the License button to open the Software License window.
Click the Edit License File ... button to open the Edit License window.
Click the Add License from a File... button to browse for the License file (*.lic).
Select the License file and click Open. The license becomes visible in the Edit License window.
Click OK to save the License. The license is saved in the License folder.
Exit the application and run the Viz World Server.

5.2.6 Maps
The Maps section is used to define the following general map settings:

To Connect to the Server
To Manually Add a License File
To Add a License File Using the Maps Server Configuration Tool
To Add a License File Using Viz World Classic
Database
Database Features
Disputed Regions
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Default Projection
Map Legend
Locations
User DEMs
Attribution
To Position the Attribution Image
Bing
Digital Globe
Google Maps
Proxy Settings
Display
Street Admin
Imported Data
Plug-ins
Place Finder

Database

Database: Selects the database type. It only displays location entries that are visible in the map area.
Shared User Map Data: Defines the source of data used by the database.
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Database Features

Accented characters: Handles accent characters in labels such as ~ in España.
DataBase Features: Defines whether the WME search tool uses additional databases in the system or only 
the Viz World database.

Disputed Regions

Region: Displays a list of the disputed regions defined in the system. Select one of the disputed regions to be 
configured.
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Configuration: Displays a list of region and border options related to the selected disputed region in the 
Region parameter. Select an option from the list and the graphic display changes according to the selected 
option.

Default Projection

Sets the default projection for when a client opens a template that does not have a map layer. The following 
options can be set:

Globe: Sets a globe projection.
Cylindrical Equidistant: Sets an unprojected map. Longitude and latitude are mapped directly into X and Y 
coordinates.
Miller Equidistant (37 30): Relative distances are correct. Angles are correct around 37 degrees 30 minutes 
North.
Miller Equidistant (43): Relative distances are correct. Angles are correct around 43 degrees North. 
Minimum scale distortion over continents.
Miller Equidistant (50 28): Relative distances are correct. Angles are correct around 50 degrees 28 minutes 
North.
Gall Isographic: Relative distances are correct. Angles are correct around 45 North.
Lambert Cylindrical Equal Area: A cylindrical equal area projection that uses the equator as the parallel of 
no distortion.
Behrman Cylindrical Equal Area: A cylindrical equal area projection that uses 30 degrees North as the 
parallel of no distortion.
Tristan Edwards: A cylindrical equal area projection which uses 37 degrees 38.3 minutes North as the 
parallel of no distortion.
Peters: De-emphasizes area exaggeration in high latitudes.
Gall Orthographic: A cylindrical equal area projection that uses 45 degrees North as the parallel of no 
distortion.
Balthasart Cylindrical projection: An orthographic projection onto a cylinder secant at the 50 degrees 
parallels. It is cylindrical equal area, but the distortion of shape increases with distance from the standard 
parallels. Scale is true along the standard parallels and constant between two parallels equidistant from the 
equator. This projection is not equidistant.
Mercator: Mercator projection. Scale and angles correct only at the equator. Very distorted at the poles.
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Miller: Distances and angles are only correct on the equator. Shapes and areas are distorted, especially at 
the poles, but less than with Mercator.
Albers Equal Area Conical: A conical projection that is useful for maps that are wider than they are high, 
such as the continental United States.
Stereographic, Polar Stereographic (North and South): A projection that has minimal distortion at the 
center of the map. Most useful for maps that are zoomed in to show whole countries.
Transverse Mercator: A projection that has minimal distortion at the center of the map. Most useful for 
maps that are zoomed in to show whole countries.

Map Legend

Sets the default unit titles for map legends.

Locations

The Locations parameters define the path to folders containing relevant data for the specified parameters.
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The Natural Earth option can be used to add, remove, and color correct global and/or local CMR (Curious Multi-
Resolution) imagery. Global imagery is what is typically used as base maps, whereas local imagery is more detailed 
imagery of local places (for example, coastal areas and cities).

User DEMs

The User DEMs (Digital Elevation Models) define the path to a folder containing elevation data.
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Attribution

Defines where the attribution should be placed on the screen.

Attribution image (gray rectangle): Sets the location of the attribution image on the screen.
Output Attribution Font: Sets the font used for the on screen credit.

To Position the Attribution Image
Drag the gray rectangle that represents the attribution image area to the desired position.

Bing

Bing Maps Platform (previously known as Virtual Earth) is a set of images (satellite and others) stored on Microsoft’s 
Bing Maps Platform servers. The images can be used by Viz World Classic but requires a credit mark (Attribution
image) to be displayed on the screen.

Bing Cache: Defines a cache folder for the images retrieved from the Bing Maps Platform server.
Empty Cache: Deletes all files from the cache folder.
Bing Connection: Allows you to test that the Bing Maps Platform server is online.

Note: Microsoft Bing requires an internet connection and does not work without a license.
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Digital Globe

Digital Globe cache: Sets the location of the Digital Globe cache. For reference, see the Bing section.
Digital Globe URL: Displays the URL of Digital Globe endpoint.

Note: Digital Globe requires an internet connection and a license. If used without a license a watermark 
appears.
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Google Maps

Empty Cache: Clears the cache.
Cache location: Sets the location of the Google Maps cache. For reference, see the Bing section.
Test Google Maps Connection: Tests the connection.

Proxy Settings
The Viz World Server should be allowed to access the following servers:

http://www.digitalglobe.com
https://securewatch.digitalglobe.com
https://api.maxar.com/
https://api.vizworld.vizrtcloudplatform.com

Note: Google Maps requires an internet connection and a license.

http://www.digitalglobe.com
https://securewatch.digitalglobe.com
https://api.maxar.com/
https://api.vizworld.vizrtcloudplatform.com/
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Display

Alternate Label Display: Sets a custom language and defines the labels’ source priority, affecting the list of 
label options displayed to the user. For creating multi-language files and using them see the Map Name 
Editor and the Using the Map Name Editor sections.
Street Data: Defines the visual properties of street edges when drawn on the maps.
Auto Feature Preview: Defines what features are shown in Viz World’s Map Editor (WME) when pressing the 
auto features button.
More Label Settings

Prefer Region Capital Label: When turned On  the auto-features force the type of feature to Region 
Capital instead of based on the default feature size (for example, Town 1K, Town 1M).
Automatically scale map labels: When this option is checked, changing the size of a project or TPL 
label styles also scales the labels proportionally.

Fit Map by Width

Note: This only applies to label styles created in Viz World Classic and used with the Map Editor Classic.
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Street Admin

The Street Admin section is used to display information about the loaded roads data in the system and road data 
licensing information.

Re-Scan: Checks the loaded street data and refreshes the display when pressed. Viz World Server must be restarted 
after a completed Re-Scan.

Alternatively, Viz World Server can be configured to automatically re-scan street data every time it starts. This 
configuration is available by editing the configuration file normally located in C:\ProgramData\Vizrt\Viz 
World\VizWorld.ini:

Under the section header [SOFTWARE\[vizrt]\Viz World], the auto scan can be turned on or off by setting the key 
AutoScan to either 1  or 0 .

To enable auto scan:

[SOFTWARE\[vizrt]\Viz World]
AutoScan=1

To disable auto scan:

[SOFTWARE\[vizrt]\Viz World]
AutoScan=0

Imported Data
Allows you to add shape files (shapes, lines, names and so on) which later can be imported to Viz Artist through the 
Map Editor (WME) and added to your map.
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Plug-ins

A list of plug-ins that are used for searching the web (not the Viz World database).

Place Finder

Viz World Server allows receiving maps of locations/features, same as the Place Finder plug-in. This can be used by 
Escenic or any other web application, or for demonstrations of Viz World.

5.2.7 Standalone Clients
A standalone client is an application running WME on machines without a Viz installation.

Export Folder: Defines the save path for standalone client applications.
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• Export Formats: Image formats are presented to users when saving images. Add a format for each 
combination of file format and compression options you wish to use. The Options button allows you to set 
color (black and white, grayscale, 256 colors, etc.), and filter options.

5.2.8 Symbols
Symbols are created and exported from Viz World Classic, and can be imported using the server configuration tool 
such that client users can add them to their maps.
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5.2.9 Timeouts

This section is used to set server timeout values.

User Timeouts: Sets the timeout values for clients logged onto the server:
Minutes Inactivity (Plugins): Sets the timeout for client connections when the WME is opened 
through the CMWClient plug-in. If no map requests are sent to the server during the period of time (in 
minutes) specified in this parameter, the server disconnects the client.
Minutes Inactivity (Interactive Navigator): Sets the timeout for client connections when an 
interactive Navigator scene is used. If no map requests are sent to the server during the period of 
time (in minutes) specified in this parameter, the server disconnects the client.

Periodic Restart: Enables automatic restarts of the server. It is mainly targeted at 24/7 stations, where Viz 
Engines are up and constantly requesting maps. The Automatic restart enables the server to restart at the 
specified time or after a defined period of time, disconnecting all clients and clearing used memory. This is 
important when the server is used heavily and a lot of maps are generated.

Restart server periodically: Sets the server to restart periodically based on the After or At Time
parameters.
After: Sets the amount of time (hours) for how long the servers should be running before the server 
should be automatically restarted.
At Time: Sets the time for when the server should be restarted.

5.2.10 Proxy Server
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This section is used to define the proxy server connection settings. Viz World Server connects to the internet to fetch 
data from Bing Maps Platform or Imagery on Demand servers. If the system uses a Proxy Server that requires 
authentication, this page is used to provide the login details for the Proxy Server.

Name: Sets the user name.
Password: Sets the user password.

5.2.11 Server Logging

This section defines whether the server logs system messages to a log file.

See Also

Symbols Tab
Map Name Editor
Using the Map Name Editor
Maps Configuration
Bing
Digital Globe
Google Maps

Note: The supported proxy authentication methods are HTTP Basic and HTTP Digest.
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5.3 Cache Configuration
When working with Viz World in a server/client environment, a cache is used to reduce the load time of scenes in Viz. 
The cache is a shared network storage folder, common to all Viz Engines in the system. The cache is managed by the 
Viz Engine machines.

This section contains information on the following topics:

Map Data Flow
Cache Location
Defining the Cache
Cache Folder Structure
Caching - Viz Trio
Caching - Viz Pilot

5.3.1 Map Data Flow
The maps data stored in the cache is produced by the Viz Engine machines, running World Map Editor applications. 
When WoC is launched, it connects to the server and enables the user to select a map and add information to the 
map. When the user accepts the selected map (by pressing the OK button in the maps editor (WME), the map 
information is sent to the scene (and to the relevant WoC plug-ins used in the scene) from the server. WoC plug-ins 
load the received data and then store it in the cache. Now, when a scene is initialized, the WoC plug-ins look for the 
data in the cache and load it, without connecting to the server.

Since the most time-consuming task in this process is generating the maps, using the cache reduces that time to a 
minimum and the maps are generated only once.

5.3.2 Cache Location
The following are some simple guidelines that ensure caching is optimized when using one or several Viz Engines.

One: Set the cache location local to that renderer.
Two or more: Set the cache location to the map server (or other shared network drive) so that one renderer 
is not favored over others.

5.3.3 Defining the Cache
The client cache is defined using Viz Engine’s configuration tool (Viz Config). When configuring the cache 
environment make sure that the following parameters are identical on all Viz machines:

Note: In complex environments, Viz Engine machines can be grouped so a different cache is defined for 
each group.

Note: Before setting a cache folder in a server/client environment, a shared network drive, mapped on all 
Viz Engine client machines should be created. The cache folder is defined on the shared drive, so all 
machines have access to the cache.
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4.

5.

6.

1.

2.
3.
4.
5.

Cache Directory
On Disk (Days)

To Configure the Cache Directory

Start Viz Config or open the configuration interface by clicking the Config button on the main menu in Viz 
Artist.
Select the Maps section.
Set the Cache Directory to the defined shared network drive and the folder used as the cache’s main folder.

Set the Memory (Images) to the required value (default is 32 ). This parameter defines the maximum 
number of map images stored in Viz memory when initializing a playlist.

Set the On Disk (days) parameter to the maximum number of days that the images are stored in the cache. 
When Viz is launched, it cleans the cached map images that are older than the value defined in the On Disk 
(days) parameter.
Click Save.

To Configure the Second Cache Directory

Start Viz Config or open the configuration interface by clicking the Config button on the main menu in Viz 
Artist.
Select the Maps section.
Set the 2nd Cache Directory to your local computer or a defined shared network drive.
Optional: Enable network monitoring.
Click Save.

5.3.4 Cache Folder Structure
When using cache in a client/server configuration, WoC plug-ins manage the cache and sort generated data in 
several folders under the cache folder. The cache folder hierarchy is created automatically. Only the cache root 
directory is configured in Viz. The defined cache folder for all clients is the root cache folder. Under the root cache 

Tip: Control clients should have their cache location(s) set to the same location as defined by the Viz 
Engine(s).

Note: The Cache Directory has to be identical on all Viz Engines that share the cache. UNC paths are also 
supported.

IMPORTANT! Set the number of images to zero (or a low value) on control machines used in the system. 
The control machines are inferior to Viz Engine machines and it makes no sense to load a large number of 
images when it is only used for preview.
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folder, a version sub folder is created using the WoC plug-ins version. Under each version folder, several sub folders 
are created, according to the requested data:

3DLine-Cache: Stores lines from the WME as OpenGL vertices.
3DBorder-Plugin-Cache: Stores selected borders based on the Region-Cache data.
3DRegion-Plugin-Cache: Stores selected regions based on the Region-Cache data.
AtlasCacheFolder: Stores Downloaded images from Microsoft to enable a smooth animation and faster 
response time during navigation. Images are stored under sub-folders according to the texture compression 
used.
BorderManagerFullWorld-Cache: Stores unselected borders based on the Region-Cache data.
CWMClient-Cache: Stores map images and label information that is reused by Viz when loading the scene.
Region-Cache: Stores region vector data.
Street-Cache: Stores street vector data.
StreetManager-Cache: Stores unselected streets based on the Street-Cache data.

General Caching Rules
The CWMClient-Cache folder is cleaned when Viz is launched (any of the Viz Engines using the cache), according to 
the On Disk parameter value.

The data in the cache folders (except for the CWMClient-Cache) are not deleted when cleaning the cache since it 
does not change and it can be reused all the time.

5.3.5 Caching - Viz Trio
This section describes Viz Trio specific commands/actions that influence how map data is cached when Loading 
Pages, Initializing All Pages and performing a Direct Take.

Loading Pages
Opening a scene for preview generates all cache files needed for the scene in the file cache. Any change to the page 
through Viz Trio (CWM location, hop locations, labels, selected regions and so on), immediately generates all 
required cache files. When pressing Take, Viz Engine loads to memory all needed map cacheable elements through 
the file cache that the preview machine just generated without the need to connect to the map server.

Note: The 3DBorder-Plugin-Cache, 3Dregion-Plugin-Cache and BorderManagerFullWorld-Cache are based 
on Region-Cache data after a projection is set, and converted to an OpenGL format.

Example: The country Norway has only one cache file under Region-Cache (since there is only one 
Norway), but could have many under other folders with different projections.

IMPORTANT! Set the same cache directory for the local Viz, and program and preview channels.

Note: Applies only if both of them have same cache folder.
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Initializing All Pages
The Initialize All button/command loads all scenes to memory (program and preview renderers). All necessary map 
data is loaded from the cache files.

Direct Take
The Direct Take button/command immediately loads the scene into Viz Engine. All necessary map data is loaded 
from the cache files that the preview has generated once.

5.3.6 Caching - Viz Pilot
Caching of map data can be achieved by running Viz Pilot’s Thumbnail Generator on the same machine as your Viz 
Engine.

See the Viz Pilot User Guide on how to setup and configure the Thumbnail Generator.

When running Viz Pilot in a non-preview configuration, any change to any map element that requires caching does 
not create cache files. This results in longer loading time of the Viz Engine because data maps, labels and polygon 
data have to be requested from the map server. It is important to request at least a single image preview, such that 
cache files are created.

See Also

To Configure the Cache Directory
Viz Artist and Viz Engine Configuration
Viz Pilot User Guide

Note: It is assumed that each page has been loaded in preview once before, and that cache files have been 
created.

Note: It is assumed that each page has been loaded in preview once before, and that cache files have been 
created.

IMPORTANT! If you are running a local Viz, set the same cache directory for the local Viz as for the program 
and preview channels.

http://documentation.vizrt.com/viz-pilot
http://documentation.vizrt.com/viz-pilot
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6 World Map Editor
The World Map Editor (WME) is a component of the Viz World Client. WME allows you to browse and select map 
features, similar to those created using Map Editor Classic. In comparison with Map Editor Classic, Map Editor offers 
almost the same features, which allow you to create stunning maps in no time.

This chapter contains information on the following topics:

Getting Started with the World Map Editor
World Map Editor Shortcuts
Tools



Viz World User Guide -  24.0

Copyright © 2025  Vizrt                                                          Page  54

1.

2.
3.
4.

6.1 Getting Started with the World Map Editor
When the Viz World Client is installed you can start the Map Editor and connect to the Viz World Server. Once 
connected you are able to open existing design projects.

6.1.1 To Start the Map Editor
Normally the Map Editor will be launched from Viz Trio, Viz Artist or Viz Pilot.

6.1.2 To Connect to Viz World Server

Start the Map Editor.

Click the Settings button .
Set the Viz World Server hostname. If not specified, the Map Editor connects to localhost.
Click Save.

Note: When the Map Editor is launched from a Vizrt application (for example, Viz Trio, Viz Artist or Viz 
Pilot), it automatically connects to the server that has been configured within that application, rather than 
the server configured within the Map Editor.
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6.2 World Map Editor Shortcuts

Where you are Function Key and/or Mouse

While in detail map editor Cancel edits ESC

Save edits ENTER

While in detail list editor Cancel edits ESC

Start edit F2

Fit to detail Multiply

Center to detail Divide

Remove detail Minus

While on a list feature Fit to feature Multiply

Center to feature Divide

Add feature Plus

Remove feature Minus

While in preset edit mode Cancel edits ESC

Save edits ENTER

While in shape edit mode Cancel edits ESC

Save edits ENTER

Delete shape DEL

Fit to shape Multiply

While on first look list Clear filter ESC

While on main view Open project browser CTRL + O
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Where you are Function Key and/or Mouse

Save favorite CTRL + S

While pan tool selected Zoom tool while key pressed CTRL

While zoom tool selected Pan tool while key pressed SPACE

While shape tool selected Zoom tool while key pressed CTRL

Pan tool while key pressed SPACE

While street tool selected Zoom tool while key pressed CTRL
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6.3 Tools
This section contains information on the following topics:

Map Editor Toolbar
Settings
Search
Layers
Extra Data Manager
Details
Shapes Tool
Streets Tool
To Show or Hide Map Features
Quick Map
Locator and Preview
Preset Editor
Multihop Editor

6.3.1 Map Editor Toolbar
The Map Editor has the following toolbars:

Horizontal Toolbar
Vertical Toolbar
Quick Map Toolbar
Locator and Preview Tabs

Horizontal Toolbar

The horizontal toolbar contains the following options:

 Save Favorites: Saves current project as a favorite project. Unlike projects which only contain the base 
map styling, a Favorite is a project which also has data saved as part of it, such as selected countries, loaded 
streets, and labels.

 Open Favorite: Opens a favorite project.

 Open Project: Opens existing map template files.

Note: User favorites are not synchronized across servers when working with server allocator. When 
working with multiple servers, synchronizing user favorites can be done as an automated process of 
replicating the relevant folders. User favorites are stored by default under C:\Program Files\Vizrt\Viz 
World\Users\Default\Favorites.
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 Undo: Undoes last change.

 Redo: Redoes last change.

 Copy Map to Clipboard:
Click the icon to copy the current map view, and its details, to a clipboard that can be used later on 
when reopening World Map Editor.
Select a previously copied map from the dropdown. The clipboard is a local list, for the currently 
active directory.
Delete an item from the clipboard list by right clicking an item and selecting Delete from the context 
menu.

Search: Search the map.
Select stylesheet: Select one of the template’s available stylesheets. If the stylesheet uses either Digital 
Globe or Microsoft Bing, an additional dropdown allows you to select the profile of imagery to use from the 
provider. The different Profiles provide a different imagery set for the same location.

 Notifications: Displays notifications of errors.

 Settings: Changes the Settings (Viz World Server, Language, Map Legend, Safe Guide).

 Information: Displays version information about the Viz World Client and Server.

Vertical Toolbar

The vertical toolbar contains the following options:

 Layers: Enables you to search for and filter features based on the current map Layers in view.

Note: +Vivid provides a set of seamless tiles of imagery for every level, however some images may not be 
the most recent imagery. The +Vivid option on Digital Globe is a paid subscription, contact your local Vizrt 
Sales representative if you require a license.
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 Details: Shows the Details for all selected features. Right-clicking the button opens a context menu that 
allows you to fit to, center to or clear all details.

 Pan: Enables the user to click and drag on the map to move the map in the direction of the drag.

 Zoom: Zooms the map according to the area selected. To select an area, click and drag to draw a 
rectangle.

 Shapes tool: Opens the Shapes Tool. Right-clicking the button opens a context menu that allows you to 
select the shape.

 Streets tool: Opens the Streets Tool.

 Inverse Colors: Toggles the color of the map legend and map features (countries, cities, etc.) See 
Settings for how to enable/disable the map legend.

 Show/Hide Features on Map: Shows or hides the selected map features. Click the arrow to select which 
map features to show. See Show or Hide Map Features.

Quick Map Toolbar

 
Use this to access the Quick Map features.

Locator and Preview Tabs

Use this to access the Locator and Preview features.

6.3.2 Settings
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Server: Sets the Viz World Server hostname. If not specified, the Map Editor connects to localhost.
Language: Selects from the available map languages. See Map Name Editor for information on how to 
configure the languages.
Map Legend: Enables or disables the map legend.
Safe Guide: Enables or disables a safety area around the map (for example, for text safety).

6.3.3 Search

The search option allows you to search for, and add notable locations to the map. The map can then be fitted, or 
centered around these locations.

From the results list, each item has the options:

: Adds/removes the selected location to/from the map.

: Fits the map to the selected location.

: Centers current map view to the selected location.

All locations that have been added to the map can also be edited from the Details view.

6.3.4 Layers

Places

Enables you to search for and filter features based on the current map layer in view. You can also sort based on 
Country, Name, and Type.
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Streets

This tab allows users to load street data by clicking Select Streets to Load, and using the Extra Data Manager, as 
well as add items to the map using the Extra Data Browser.

The roads in the visible map can be loaded into the list by clicking Load Visible Streets.

Shapefile

This tab is to allow users to load Extra data such as Shape files.

KML

The KML Manager lets you load Keyhole Markup Language (KML) files which can then be added to the map. The KML 
file can be uploaded from the Viz World Server or opened from a local file.

Load: Loads a file from the Viz World Server. Clicking the Load button, opens the KML Browser and lists all 
the available KML files. It works the same way as the Extra Data Browser.
Open: Opens a file from the file system, but does not copy it to the Viz World Server.
Upload File: Opens a file from the file system and copies it to the Viz World Server.

Note: If the KML file includes a camera position, then the map zooms to that position, otherwise the map 
focuses on all of the data found in the file.
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KML files can also be manually imported into the server, and must be placed in the following folders:

32-bit:
C:\ProgramData\Curious Software\Curious World Maps\KML
C:\ProgramData\Curious Software\Curious World Maps\Users\Default\KML

64-bit:
C:\ProgramData\vizrt\Viz World\KML
C:\ProgramData\vizrt\Viz World\Users\Default\KML

Any files uploaded from the client are stored in this same location.

6.3.5 Extra Data Manager
The Extra Data Manager is available from the Layers Tool and allows users to manage extra data that is stored on 
the Viz World Server.

To Use Extra Data
In the Layers tool, click on the Streets tab, to open the Extra Data Browser. (This is empty if no data has been 
selected).

Click on Load Streets to open the Extra Data Manger.
Navigate to the required data and use the Add, Fit and Centre buttons to select the data and/or move the 
map.
Close the Extra Data Manager when finished.
Open the Extra Data Browser again to see all the loaded data and add features which are related to the 
loaded data.
Data can be deselected either from within the Extra Data Manager or the Extra Data Browser, using the X
button.

Extra Data Manager
In the Extra Data Manager, the view can be switched between Flat List view and Tree view, using the buttons at the 
bottom of the window.

The Flat List view presents the data in a flat structure with a navigation bar at the top. To navigate in the data, 
double-click an item in the list to open it, or use the drop-down menus. In this case, the Filter only filters the content 
of the current directory.

Note: In order to work with Extra Data, the Viz World Server must have data loaded.

Note: Streets data requires additional license features and the installation of street data on the server.
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The Tree view presents the data in a hierarchical structure. To navigate in the data, double-click an item in the list. 
The Filter filters the whole tree and lets you navigate within the results using ENTER and SHIFT + ENTER keys or the 
^ and v buttons.

Extra Data Browser
The Extra Data Browser displays all the loaded data and can be used to add features which are related to the loaded 
data.
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6.3.6 Details

The Details view allows you to edit the name and appearance of details. Changes can be made to multiple details by 
selecting them together. The details in the list can be reordered by dragging them, or easily hidden from the map.

Custom styles and style families can be created in the Map Designer using the Style Editor. These styles are then 
available in the Editor.



Viz World User Guide -  24.0

Copyright © 2025  Vizrt                                                          Page  65

•
•
•

•
•
•
•

The icon used for each detail can be changed by selecting the detail in the list and browsing for a new icon in the list 
of icons.

Details can be sorted alphabetically using the  buttons.

Show/hide each detail, without removing it from the list, by clicking the  icon. When a detail is hidden, it is 
not rendered in the scene.

Clicking the Edit button next to each item in the Details list allows editing the following features:

All Caps: Sets all capital letters on or off.
Add to Database: New name alternatives (for example, language specific) can be saved to the database.
Label Location: Adjust the location of the detail’s label.

The context menu provides the following options:

Fit to details: Fits the map according to the selected details.
Center to details: Centers the current view according to the selected details.
Remove details: Removes all selected details.
Clear all details: Removes all details regardless of selection.

Note: If the default style defined in the server is not available in the scene designs, then the first design 
which is available in that scene is used.
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6.3.7 Shapes Tool

The Shape Tool lets users draw shapes on the map.

Context Menu
A right-click or a long left-click on the Shapes Tool icon presents a context menu with the following options:

Spline Shape: Draw segments of a smoothed, curved line. It can be closed or open. Double click to finish 
drawing.
Linear Shape: Draw straight-line segments. It can be closed or open. Double click to finish drawing.
Closed Shape: The shape drawn is closed (the first and last points drawn are joined).
Fill Shape: The shape is filled. Forces the shape to be closed.
Circle / Ellipse / Rectangle: Select a geometric shape. If none are selected, the tool defaults to drawing a 
spline or linear shape.

Edit Mode

When the Shapes Tool icon is selected, clicking on an existing shape presents the Shapes toolbar:

Lock/unlock the handles (only relevant to spline shapes): Allows the shape to be modified more flexibly.
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1.
2.
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Remove the shape from the map.
Fit the map to shape.
Center the map on shape.
Convert shape to spline/linear (not relevant to geometric shapes).
Make shape closed/open (only relevant to lines).
Fill the shape with color.
Change the shape style (for example an ellipse can be a Region or a Country). Note that this may affect the 
appearance in Viz Artist scenes.

Shortcut Keys
When a shape is in edit mode, the following shortcuts keys are available:

DELETE key deletes the shape.
* (asterisk) key centers the map on the shape.

At any time, pressing the D key activates the Shape Tool. When the D key is released, the previously active tool 
becomes active and the shape is submitted to the Server.

To Add a Shape to the Map
Click on the Shapes Tool icon to activate it.
Right-click on the Shapes Tool icon. A context menu appears.
Select the kind of shape to draw, for example an ellipse.
Drag on the map to create a shape. When the mouse button is released, the shape is submitted to the Viz 
World Server.

To Edit an Existing Shape
Click on the Shapes Tool icon to activate it.
Click on the shape you want to edit. A toolbar appears next to the shape.
Use the Shape Tool to modify the shape.

6.3.8 Streets Tool

The Streets Tool can be used to add streets or segments of streets. It uses the data that has been added by the Extra 
Data Manager.

When the Streets Tool is activated, a red dot appears when the mouse is hovered over a street. Clicking on the red 
dot brings up the Streets Tool menu bar.
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The Streets Tool menu bar contains:

Add Segment: Allows the user to add segments of the street. Each click on the map adds a segment. Double-
click to finish the operation and submit the shape to the Server.
Add Street: Add the selected street to the map.
Label Street: Add just the label without the line.
Fit the map to the street.
Center the map on the street.

Once a street is added to the map, the user can edit it using the Shapes Tool.

6.3.9 To Show or Hide Map Features

The Show/Hide Map Features button toggles the features on and off. If they are on, a summary of features is also 
displayed.
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To configure which features are displayed, click the arrow and select which map features to show.

To modify a feature, you can also hover over the feature on the map to display the tool bar.

6.3.10 Quick Map

The Quick Map toolbar allows quick navigation to regions, countries and cities. It works together with the Locator 
tab to identify the location of the map segment which is currently displayed in the Map Editor window.

Q: Click on the Q icon to filter the drop-down lists and configure which features are listed in them.
Globe: Provides quick access to regions of the world, for example, Asia, Middle East, Europe.
World drop-down: Select a country.
Country drop-down: Select a State or City.
Click on the drop-down headings (for example, World or Australia) to zoom to the corresponding level 
(world or country).
Type in the text field to search for countries, regions or sub-regions.

Note: You can also show or hide individual details, using the Details tool.
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6.3.11 Locator and Preview

The Locator-Preview tabs display the following information:

Locator
Select an area and the map zooms to that location.

Preview
If the Map Editor was opened from Viz Artist, Viz Trio or Viz Pilot, the Preview tab generates a snapshot of the Viz 
Scene. For Viz Pilot, it only works if a preview server is configured.

6.3.12 Preset Editor
Right click on the Locator to display a list of predefined regions.

Note: The Preview Server URI must include the http prefix (for example, http://localhost:54000). In Viz 
Pilot 5.7.x and earlier, check the setting in Viz Pilot under Options > Preferences > Advanced > 
preview_server_uri. In Viz Pilot 6.0 or later, check the setting in the Data Server under Settings > VCP 
Parameters > preview_server_uri. For more information, see the section ‘To give applications access to 
the Preview Server’ in the Viz Pilot User Guide.

http://localhost:54000
http://documentation.vizrt.com/viz-pilot


Viz World User Guide -  24.0

Copyright © 2025  Vizrt                                                          Page  71

• Add your own presets to this list by right-clicking and selecting Add Current View as Preset. Then enter a 
name for the preset.
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Edit your presets by right-clicking and selecting Edit Presets. In the window that appears, you can rename, 
reorder, delete, or duplicate the custom list.

6.3.13 Multihop Editor
The Multihop Editor allows users to control the number of hops on a template. For example, if a scene was designed 
with two hops, the user in Viz Trio would be able to add up to 30 hops.

To Enable the Multihop Editor
The Multihop Editor is hidden by default, but can be enabled in the following ways:

If a scene contains a Control Multihop plug-in, then when the World Map Editor is opened from Viz Trio or Viz 
Pilot, it includes the Multihop Editor.
When a scene in Viz Artist contains the Hops Manager plug-in, then pressing the Multihop button opens the 
World Map Editor, including the Multihop Editor.

Using the Multihop Editor
Once enabled, the Multihop Editor appears on the right-hand side of the World Map Editor, and shows all the hops 
that are defined. The hops can be reordered by dragging them to the desired place in the list.
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Multihop Editing Options

A context menu on the Multihop Editor displays the following options:

Cut, Copy, Paste, Duplicate or Remove items in the list.
Change Style: Select one or more hops and change their style. The change only applies to the selected hops.
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• Change Project: Select one or more hops and select a new map template file for these hops. The change 
only applies to the selected hops.

Note: To change the style of ALL hops, use the Select stylesheet button in the Horizontal Toolbar.

Note: To change the project of ALL hops, use the Open Project button in the Horizontal Toolbar.
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7 Map Designer
The Map Designer is a component of the Viz World Client (WoC). Map Designer allows you to create map templates 
similar to those created using Viz World Classic. In comparison with Viz World Classic, Map Designer offers just the 
core features, which allow you to design stunning maps in no time.

Map Designer shares much of the functionality of the World Map Editor, and as such, all shared features are 
described in the World Map Editor section, with only the additional features of the Map Designer covered in this 
section.

This chapter contains information on the following topics:

Getting Started with the Map Designer
Map Designer Toolbars
Stylesheet Editor

Note: Currently the Map Designer is only able to work with flat maps.
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7.1 Getting Started with the Map Designer

Once you have the Viz World Client installed, you can start the Map Designer and connect to the Viz World Server. 
Once connected you are able to open existing design projects, use existing templates, create new templates from 
existing templates, or create a template from scratch using a blank template.

7.1.1 To Start the Map Designer
The Map Designer can be started from the desktop or start menu (Viz World Design Client), or from the installation 
directory (MapsDesignClient.exe):

32-bit system: C:\Program Files\vizrt\Common\Maps
64-bit system: C:\Program Files (x86)\vizrt\Common\Maps

7.1.2 To Connect to Viz World Server
Start the Map Designer.
Click the Settings button, located on the toolbar.
Set the Viz World Server hostname. If not specified, the Map Designer connects to localhost.
Click Save.
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7.1.3 To Create a Map Template

Start the Map Designer.
Select one of the following options:

Open Project: Opens an existing project.
From Template: Starts a new project based on a selection of default stylesheets.
From Existing: Starts a new project based on an existing project.
Blank: Starts a new project.
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7.2 Map Designer Toolbars
The Map Designer has two toolbars, and most of the functions are the same as the Map Editor Toolbar. The 
functions that differ are described in this section.

7.2.1 Horizontal Toolbar

The horizontal toolbar is the same as the Map Editor Toolbar, with the exception of:

New Project: Creates a new map template (see Getting Started).
Open Project: Opens existing map template files.
Save Project: Saves the current map template file.
Save Project As: Saves the current map template file as a new file.

7.2.2 Vertical Toolbar
The vertical toolbar is the same as the Map Editor Toolbar.
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7.3 Stylesheet Editor

The Stylesheet Editor is in many ways similar to working with the Styles Editor in Viz World Classic. You can define 
styles for land, sea, borders and so on.

This section contains information on the following topics:

Add and Organize Stylesheets
Customize Styles
Default Values
Land
Sea
Miscellaneous
Extra Data
Borders

7.3.1 Add and Organize Stylesheets
While working on your template’s style sheets you can Add new or existing style sheets from other projects to your 
own project. In addition you can Organize your own style sheets.

Add

 
When adding stylesheets you can select one of the template stylesheets, or a stylesheet from an existing project or 
simply a blank stylesheet:

From Template: Browse for and select one or multiple existing stylesheet templates and add them to your 
project.
From Existing: Browse or search for stylesheets from existing Projects. Select one or multiple existing 
stylesheets and add them to your project.
Blank: A new blank stylesheet is added and opened.
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Organize

When organizing stylesheets, the stylesheets in the project are listed, and it is possible to perform the operations; 
Duplicate, Rename, or Delete.

Additional stylesheets can be added using the Add button at the top of the Organize window.

7.3.2 Customize Styles
Use the Styles Editor to edit and customize the styles of points, lines and areas. These styles can then be used in 
your Viz World project.

Open the Styles Editor from the Stylesheet Editor toolbar.
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1.

2.

Styles Editor

Style families are listed on the left, and default styles on the right. The Styles Editor comes with a predefined list 
of families and styles that can be used as-is, or can be edited or removed. Drag styles to reorder them or move them 
from one family to another.

The styles are global to the system and are available in the World Map Editor, based on what is available in the Viz 
scene. Any style in the system that is not part of the scene is disabled in the editor, and any style that is part of the 
scene but is not defined as part of the global styles is available in the Others family.

To Create a New Style Family
In the Styles Editor, click the New button to create a new family, then give it a name.

Within the family, click the New Style button to add new styles.
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Fill in the details for the style:
Type (point, line, area).
Name.
Icon: Select a new icon in the file browser.
Color, opacity etc. Only possible for Area and Line.

Click Save Changes.

To Select a New Default Style

Drag a style from the family list to the default list, and drop it on the desired style.
Click Save Changes.
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7.3.3 Default Values

Settings which use the default values have a grey square next to them. If the value differs from the default, the 
square turns white. Click a white square to return the values to default.

7.3.4 Land
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The Land settings allow you to define the Style of the map and its fill colors, as well as the Drop Shadow and Relief 
Shading effects.

Style
When defining land styles you first select whether the map should have a Synthetic, Relief or Natural style.

Synthetic gives the map a basic style, where you can select a single Fill Color or four fill colors. If you select 
four fill colors, no country, adjacent to each other, all have the same color. Both Relief and Natural styles can 
mix with Synthetic utilizing its single or four color option. The Ice Color can be set separately.
Natural gives you the option to select which satellite imagery provider to use (for example, Google Maps, 
Microsoft Virtual Earth, Digital Globe, Planet Observer, and so on). In addition you can adjust the map’s 
brightness, contrast, saturation, gamma, and tint.
If the stylesheet uses either Google Maps, Digital Globe or Microsoft Bing, you can set which imagery 
profile to use as default. The profiles provide different imagery sets for the same location. If required, the 
operator can change the profile from the Map Editor Toolbar when selecting the desired final location.

Relief contour colors work the same way as for Sea. It gives you the option to define colors at varying levels 
of height (from 0 to 8000 m.a.s.l.). Clicking below the bar adds a new handle. Double-clicking a handle opens 
a color picker for setting a color for that level. Dragging the handle horizontally adjusts the height parameter. 
Dragging the handle vertically removes the handle.
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Drop Shadow
Drop Shadow can be added to land, lakes/wide rivers, and narrow rivers. The drop shadow effect also allows you to 
adjust the angle of the shadow, and its distance and softness (spread).

Relief Shading
Relief shading can be added to land. When enabled, you can define how the light affects the relief by adjusting the 
highlight (by click and drag). The Size and Intensity settings help you control the appearance of the relief texturing 
on the map.

Refine Relief adds extra detail to the relief. This is especially helpful when zooming in at low levels.

The image below shows a map with Refine Relief enabled and disabled:

7.3.5 Sea
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The Sea settings allow you to define the color and/or contour colors of the sea, and when using satellite imagery 
how it should mix with the base and/or contour colors.

Color sets the base color of the sea.

Contour colors work the same way as for Land. It gives you the option to define colors at varying levels of depth 
(from 0 to 10000 m.b.s.l.). Clicking below the bar adds a new handle. Double-clicking a handle opens a color picker 
for setting a color for that level. Dragging the handle horizontally adjusts the depth parameter. Dragging the handle 
vertically removes the handle. Opacity blends the base color with the contour colors. The lower the value, the more 
of the base color shown.

Natural sea enables you to select which satellite imagery provider to use (for example, Google Maps, Microsoft 
Virtual Earth, Digital Globe, Planet Observer, and so on). In addition you can adjust the map’s brightness, contrast, 
saturation, gamma, and tint.

Mix with others allows you set the alpha for the mix between the base and/or contour colors and the satellite 
imagery. It mixes the colors based on whether you are near or far away from sea level. Meaning when you are close 
to sea level, it uses the near mix setting, and when far away it uses the far mix setting.
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7.3.6 Miscellaneous

Projection: Map projection either Mercator or Cylindrical Equidistant (Unprojected).

Global Map Data/Extra Map Data: For Lakes and Rivers you can select a base color (no alpha) and whether or not 
None, Major, Medium, Minor or All lakes and/or rivers should be shown.

For rivers you can also define:

Master Size affects the width of all rivers drawn as lines.
Small Rivers affects the width of rivers which are classified as minor rivers.
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• Max Width (in pixels) determines the maximum line width at which rivers are drawn. This is useful if you 
wish to prevent rivers being drawn as very thick lines as a map zooms in.

When Local Street Data is enabled, the data for lakes and rivers can be displayed.

Latitude/Longitude Lines can be enabled/disabled. The color, width and spacing are configurable.

7.3.7 Extra Data

If Local Street Data is used, the Extra Data settings allow the various types of roads to be styled.

7.3.8 Borders
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The Border settings allow you to define the border color and width (in pixels, 0.00 - 10.00 px). You can set colors and 
width for country and region borders, and coastal lines. In addition you can enable/disable disputed borders. 
Disputed borders are shown with a dashed line.
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8 Map Builder

The Map Builder is a component of the Viz World Client (WoC). Map Builder is used during design in Viz Artist to build 
maps quickly and efficiently. It is used in conjunction with the Map Builder scene plug-in.

When creating a map scene, your scene generally consists of a few basic elements. The elements are built in the 
following order:

Create a scene using the Map Builder plug-in (see Getting Started).
Choose Scene Type.
Create a Base Map.
Define the Global Hop.
Create a Navigator which can be used to create a destination list.
Set the map Orientation.
Configure the design source and object pool Settings.
Use Window to enable or disable a window mask for the scene.
Use Global Borders to generate global vector border data based on the settings applied.
Refresh the thumbnails when re-launching the Map Builder to make changes (see Toolbar and Menus).

IMPORTANT! Prior to using the Map Builder you need To Import Basic Map Elements.
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8.1 Getting Started with Map Builder

Once you have installed the Viz World Client, you can start Viz Artist and create a scene using the Map Builder scene 
plug-in. Note that the Map Builder itself by default connects to the same Viz World Server as Viz Artist. If needed you 
can switch to another Viz World Server from Map Builder’s file menu.

As a first step to work with the Map Builder you can create a scene that only contains the Map Builder scene plug-in. 
Once created you can launch the Map Builder by clicking the Launch Wizard button. This opens the Map Builder 
and allow you to Choose Scene Type.

8.1.1 To Start Creating a Scene Using the Map Builder
Start Viz Artist.
Click Built Ins and then the Scene Plugins tab.
Select the Maps plug-in folder. This shows the Map Builder scene plug-in:

Click Scene Settings and the Plugin tab.
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Drag and drop the Map Builder plug-in onto the plug-in areas placeholder.
Save the scene. Once the scene has been saved you can open the Map Builder and click the Launch Wizard
button to open the Map Builder.

8.1.2 To Import Basic Map Elements
Start Viz Artist.
Click Import and select Archives from the drop-list.
Navigate to C:\Program Files\Vizrt\Common\Maps\Archives.
Select the VizWorldGlobalDesigns.via archive.
Click Import Archive.
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8.2 Choose Scene Type

When launching the Map Builder, you are presented with the following options:

Navigator: Builds a scene with one starting point and up to 32 destinations.
Focus on Map: Creates a static scene with a base map only. Can only be used with flat geometries.
1 Destination: Builds a scene with one starting point and one destination.
Map Object: Builds a scene with one starting point and one destination. The window option is used so that 
the map only uses part of the screen.
Open: Opens existing map template files.
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8.3 Toolbar and Menus

8.3.1 Toolbar

New Map Template: Allows you to create a new map template (see Getting Started).
Open: Allows you to open existing map template files.
Save: Saves the map template file.
Save As: Allows you to save the map template file as a new file.
Refresh: Refreshes the thumbnails. Refreshing thumbnails must be done after manually editing a Map 
Builder generated scene and when re-launching the Map Builder as all thumbnails of maps (Base Map, 
Destinations and Orientation) are lost. To refresh them, click the Refresh button in the toolbar or press the 
F5 key.

8.3.2 Menus
File: Contains the same functions as the Toolbar, as well as Exit.
Tools: Contains:

Refresh thumbnails.
Map Server Settings (Viz World Server host name).
Option to enable/disable the tooltips.

Help: Contains links to the About information and the Viz World User Guide.
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8.4 Base Map

Base Map is the Globe/Flat map in a specific style and data. The map created at this level is usually good for country 
level view.
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8.5 Global Hop

Defines the camera’s trajectory animation setting. It describes how the navigation animation should be (for 
example, map start and three destination animations, each hop animation based on five seconds, with stop points 
between destinations).
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8.6 Navigator

8.6.1 Type

Type defines whether each destination is of type Geo Position Only, Map - Single Image or Pyramid of Maps.

Geo Position Only: Uses a Geo Position reference to the navigation only. This mode is useful for 
destinations that are always far away from the base map. No map is created in this mode (as it saves texture 
memory).

Map – Single Image: Enables operators to control a destination using an external application (either a Map 
or Pyramid has to be selected). If the selected destination is used for a reference point, and it needs to be 
controlled, use this type (for example, a far away starting point).
Pyramid of maps: Builds a pyramid of maps around the destination and smoothens the resolution 
difference between the base map and the destination target. Used when the base map is not suitable for 
close-ups.

8.6.2 Destinations
Each destination can consist of map elements (labels, regions and miscellaneous map elements).

Note: When destination is set to Geo Position Only, it cannot be controlled by an external application such 
as Viz Trio or Viz Pilot.
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If destinations are controlled (for example, by Viz Trio or Viz Pilot) they can be linked to each other to allow the user 
to easily control multiple destination elements. Linking is only a help to the user and has no effect on the scene.

Copying (duplicating) a destination is possible by selecting a destination and clicking the add button.

Note: The selected destination is not duplicated if the destination type is Geo Position Only.
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8.7 Orientation

The Orientation map is displayed in the bottom corner of the screen. It consists of a small map with a marker 
showing what part of the world is currently being navigated to.

There are three views available:

Center Map: Moves the orientation map according to the main map’s geographic properties.
Locator: Moves a marker on the orientation map according to the main map’s geographic properties.
Globe: Rotates a globe according to the main map’s geographic properties.
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8.8 Settings

Allows the user to specify the design source and object pool path.

Designs source: Allows designs to be shared between scenes by using the Object Pool, instead of the in-
scene designs.
Object Pool Path: Allows users to specify an alternative Graphic Hub or Object Pool folder. A custom Object 
Pool Path must use the same hierarchy structure as the default object path. The default object path is /vizrt/
VizWorld/GlobalDesigns.
Map Layer: Selects whether the scene uses the Front and Main layers, or only uses the Main layer and then 
applies a Dynamic texture for the overlaid items.
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8.9 Window

When this option is enabled, the Map Builder adds a window mask to the Viz Scene and also applies the X, Y, width 
and height values to it.



Viz World User Guide -  24.0

Copyright © 2025  Vizrt                                                          Page  102

•
•
•
•

8.10 Global Borders

This option enables Borders as vector shapes in the scene.

World: Selects whether to create full world vector borders.
Region Data: Adds regional data up to the resolution selected (Country, Region, SubRegion).
Region List: Bases the regions to be built on the selection in this field.
Country Borders: Selects whether to generate Internal Borders, Coastline Boarders or Both.
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9 Map Editor Classic
The World Map Editor (WME Classic) is a component of the Viz World Client. WME Classic can be integrated with 
numerous Vizrt products that enables users to select, frame and populate maps and use them in Viz. The WME 
connects to the Viz World Server and retrieves the map to be used.

This section contains information on the following topics:

Map Name Editor
Using the Map Name Editor
Classic Map Editor
Using the Map Editor
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9.1 Map Name Editor

The Map Name Editor is a batch feature translation tool meaning that you can use it to edit multiple language 
translations stored at the Viz World Server.

World Server: Allows you to connect to the Viz World Server using either hostname or IP address. Click the 
Connect button to connect with the server.

Once logged in you can display all features at four different region levels: World, Country, Region and Sub Region. 
However, this depends on the levels available for each country (for example, the United States of America has all 
four levels, while Oman only has three levels).

Once you have chosen the regional level you want you can further filter your result or select one or several of the 
pre-configured layer buttons.
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If you right-click in the table you can display different columns. The standard columns are Display Name, DB Name, 
Alternate Name, User Name, Abbreviations and Type. Additionally, you can add you custom language alternatives 
and choose to display them using the context menu.

See Also

Using the Map Name Editor
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9.2 Using the Map Name Editor
This section describes how to use the Map Name Editor. See the following sections for more information:

To Create a New Language File
To Add Language Specific Translations
To Use the New Language File

9.2.1 To Create a New Language File
Start Windows Explorer.
Create a folder named Languages in the following location:

32-bit: C:\Program Files\Curious Software\Curious World Maps\SharedData
64-bit: C:\Program Files\vizrt\Viz World\SharedData

In the folder, you can either place an empty file called <my language>.mdx or copy and rename 
UserNames.mdx (if you already have changed a lot of the label names).

Start the Map Name Editor executable (64-bit) found under: C:\Program Files\vizrt\Viz World
Edit the new file. Your language is added as a new column.
Click Save Changes.

9.2.2 To Add Language Specific Translations
Start the Map Name Editor.
Connect to your Viz World Server.
Right-click and select your language column representing your custom language file.
Search for the name that needs a language specific translation.
Enter the translation and click Save Changes.

9.2.3 To Use the New Language File
Start the Server Configuration tool and log on to your Viz World Server.
Select the Maps’ Display section.
Set the Alternate Label Display’s first option to be M-Language (multi-language).
Start for example Viz Artist, create a maps scene and launch the Map Editor (WME).
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Right-click the map area and select your language from the appearing context menu.

For Viz Artist add/edit the VizWorld.ini file under C:\ProgramData\Vizrt\VizEngine\Maps and add the following 
entry: language=[my Language ID]

OR (dynamically) send the following command to Viz Engine: MAPS LANGUAGE [my Language ID]

See Also

Map Name Editor
Display
Maps Configuration

Note: Setting a language in WME does not affect the language used in Viz Artist.

Note: my Language ID refers to the order in the list of languages, English = 0, Norwegian = 1, etc. See the 
above screenshot.
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9.3 Classic Map Editor

The WME window includes the map area, navigation and map editing area, map details area and the map tool bar. 
The user can select (zoom and pan) a region on the map, or use the search tool to find the requested location. The 
user can add information to be displayed over the map by selecting objects from the database or by manually 
marking a place on the map. The added objects are displayed in the Map Details area.

This section contains information on the following topics:

Map Area
Navigation and Map Editing Area
Search Tab
Explorer Tab
Extra Data Tab
Symbols Tab
Map Tool Bar
Map Details Area

9.3.1 Map Area
The map area displays the current map and enables the user to modify the map interactively, according to the 
selected tool in the buttons toolbar and by using the integrated Zoom Options.
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Context Menu

Guides: Allows you to display default guides (for example, safe and title area) or custom guides and/or 
images (for example, logo and background). For more information, see how To Add Custom Guides.
Languages: Defines the language setting for labels. See the Server Configuration tool’s Display section and 
how To Create a New Language File.
Server Priority: Sets the connection priority given by the Viz World Server. See the Server Launcher 
Configuration section and the Enable Priority Login option. If you are working on scene design using Viz 
Artist, Viz Artist also needs to be configured (separately). See Viz Artist’s Maps Configuration section.

To Add Custom Guides
With custom guides you have three options; two for placing an image as a background or logo and one for placing 
guides such as title and safe area boxes.

On the Viz World Server machine locate and open the CustomGuides.txt file under
32-bit: C:\ProgramData\Curious Software\Curious World Maps\Settings
64-bit: C:\ProgramData\vizrt\Viz World\Settings

Enter the following to show an image (for example, logo) on top of the map:
Syntax: Type "Title" Ratio Width(%) Height(%) "Filename" Image X(%) 

Image Y(%) Opacity(%)

Example: Image "Logo" 1.333 80 80 "C:\logo.png" 0 0 75
This adds an image on top of the map, the image is applied with 75% opacity (alpha is supported).

Enter the following to show a background image on top of the map:
Example: Image "Background" -1 90 90 "C:\background.png" 5 5 25
This stretches background.png to fit the current aspect ratio (-1) with 5% on each side as margin at 
25% opacity.

Enter the following to add a custom guide to the map:
Syntax: "Title" Ratio Width(%) Height(%)

Example: " 4:3 Title Safe" 1.333 80 80
Valid width and height values have to be between 50 and 100. Set ratio (width divided by height), or 
-1  for current aspect ratio. You can define up to five custom guides.
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Zoom Options
In the upper left corner of the Map Area there are two rectangular blue shaped buttons that can be used to zoom in 
and out of the map. In addition, it is also possible to use the mouse (left button) and/or in combination with the 
keyboard.

The zoom options, besides menus and buttons, are:

Drag and draw a rectangle to zoom in to fit.
Click the left mouse button to zoom in.
Hold down SHIFT to zoom out.
Hold down CTRL to zoom in in smaller steps.
Hold down CTRL and ALT to zoom out in smaller steps.

9.3.2 Navigation and Map Editing Area
The navigation area enables the user to locate places by searching the database or selecting a place from the 
explorer list. When a place is found (or selected) the user can fit the map to the requested area, add information to 
the map, highlight the region and modify the map.

To Use the Results
After conducting a search or using the explorer, the results are displayed as a list. When an entry is selected, the 
buttons on the right side of the list becomes enabled:

 Add to map: Adds the selected entry to the map. The selected entry is added to the map graphically as 
defined in the selected map style. A map style defines map symbols, fonts, icons, colors, and so on. For map 
styles see also Map Tool Bar and the Map Style drop-down menu.

 Center map: Pans the map to center the selected entry (keeping the current map scale size).

 Fit to fill: Centers the map and scales the map to fill the map area.

 Show details: Opens the browsing tool, which displays the context information for the selected detail. 
The context information includes the regions containing the detail (that is country, state and county) and 
the capital of that country.
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9.3.3 Search Tab

The search tab is used for searching the database for a place, using a string or sub string typed in the name text box. 
The search results can be filtered using the radio buttons and the drop-down list.

Searching is instant (after the first three characters) and optimized according to relevance; hence, if you search for 
Paris your result shows all places named Paris, but if you search Paris TX you get Paris in Texas, USA.

If you have street data (see Extra Data Tab) you can also search for crossroads using AND or & (for example, 
Broadway AND 44th).

Search Parameters

Find All: Displays all matching entries in the database when selected.
Find Visible: Displays only matching entries visible in the current map when selected.
Addr and Cross st.: Enables the user to search for specific addresses.
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Type: Limits the result list according to the selected Type. For example region, capitals, tourist attraction, 
and so on.
Source: Searches a range of sources.

All: Searches all sources.
Internal: Searches the map database and extra data.
Map DB: Searches the Viz World database.
Extra Data: Searches all extra data packages bought in addition to the standard installation (see Map 
DB).
Web: Searches Yahoo for online point data.

9.3.4 Explorer Tab

The explorer tab is used for selecting a location from a list of places derived from the server’s database. The list is 
displayed in a tree format showing countries, regions, cities, and so on.

Explorer Parameters (List Filter)

Visible: Displays only location entries visible in the current map.
Type: Limits the search result list to the selected type like region, capitals, tourist attraction, and so on, 
when one of the entries in the list of available types are selected.

Note: Searching for addresses requires licensed street data installed on the server.
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• Filter: Filters the search result further.

9.3.5 Extra Data Tab

The Extra Data tab is used for selecting a street from the streets database on the server, and Keyhole Markup 
Language (*.kml) files.

Note: To find New York, type N , then type E , etc. with every character typed in the string filter the list 
becomes smaller.

Note: Streets data requires additional license features and the installation of street data on the server.
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Streets

Streets data is available from the Streets node, and are sorted by Motorways, Primary Roads, Main Roads and Other 
Roads. Use the Filter search to search for streets.

To Import KML

Keyhole Markup Language (KML) files can be imported and added to the map. The KML data is accessible from the 
Extra Data tab as with street data. By clicking the KML Files node, all the imported KML files appear as sub nodes. 
Click one of the imported KML files to open the KML file window the respective file is a file.

KML files currently must be manually imported into the server. Files are placed in the following location:

32-bit: C:\ProgramData\Curious Software\Curious World Maps\KML
64-bit: C:\ProgramData\vizrt\Viz World\KML
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9.3.6 Symbols Tab
Symbols are added using Viz World Classic, and can be imported using the Configuration tool or Viz World Classic.

To Add Symbols
Start Viz World Classic, preferably on the maps server.
Create or open a map project.
From the Tools menu, select Symbols.
In the Symbols dialog box, click the + symbol (bottom) to search and select for a symbol.
Close Viz World Classic.
Restart the Viz World Server to load the new images.

9.3.7 Map Tool Bar

The Map Tool Bar includes a row of buttons controlling the map interactive mode. The map area enables an 
interactive map selection and manipulation and the Map Tool Bar is used for selecting the map interactive 
behavior.

Map Tool Options

Available Map Stylesheet: Displays a list of available map styles of the selected template. Select a map 
style to apply the style’s design to the displayed map.
View Presets: Displays a set of view presets. Available options are: The World, United States, N America, S 
America, Americas, Africa, Asia, Middle East, S Asia, Europe and United Kingdom.

 Open New Template: Loads one of the defined templates installed on the server creating a blank map 
with the template’s styles and settings. When pressing this button a confirmation window opens. When 
confirmed, the template window opens. Select one of the projects in the list and click OK. A new map 
appears in the map area using the new template’s default styles and settings.

 Save Favorite: Save map as a favorite.

 Undo button: Cancels the last change on the map.

 Redo button: Cancels the last canceled change on the map.

Note: Images should reside on the map server or on a shared drive.

Note: User favorites are not synchronized across servers when working with server allocator. When 
working with multiple servers, synchronizing user favorites can be done as an automated process of 
replicating the relevant folders. User favorites are stored by default under C:\ProgramData\Vizrt\Viz 
World\Users\Default\Favorites.
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Bird’s Eye: Displays the available imagery Bird’s Eye imagery from the Bing Maps Platform. When clicking 
the button, the imagery for the area of the current map is displayed enabling the user to select an image for 
the map.

Quick Map: Opens the Quick Map location browser that enables the user To Create a Map Using the Quick 
Map Location Browser.
Set Location: Opens the Set Location dialog which enables the user To Set the Map Location using 
longitude, latitude and map size values (radius around the defined point).

 Region Zoom: Enables the user to click and drag the mouse on the map to create a rectangle 
surrounding an area on the map (rubber band).

The rectangle displays two icons; a cancel icon in the upper right corner and accept icon in the lower 
left.
The rectangle keeps the aspect ratio set for the map unlike regular zoom (see below).
Region zoom can be adjusted before accepting the area selection.

 Zoom: Zooms into the map on every click on a point in the map centering the clicked point in the Map 
Area. Another option is to drag and create a selection area. When the mouse button is released, the selected 
area becomes the selected map. Selecting an area using the zoom option does not maintain the aspect ratio.

 Pan: Enables the user to click and drag on the map to move the map in the direction of the drag.

 Pick Feature: Shows a group of available places from the database as “phantom labels”. This feature 
enables the user To Pick a Label and Add it to the Map. The labels appear over the map only when an entry is 
selected in the explorer tab or in the search area.

 Browse Map: Updates the browse window (on any click within the Map Area) with context information 
for the clicked position. The context information includes regions containing the position (for example 
country, state and county) and the capital of the country.

Note: Both Region Zoom and Zoom allows for area selection in the Map Area; however, Region Zoom 
maintains aspect ratio and allows the user to cancel the operation after the selection was made.
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 Move Label: Enables the user To Move a Label in the Map Area. Map Label enables the user to move 
the tip and the caption of user-created labels or to rotate them. In other labels only the caption can be 
moved and rotated.

 Add Label: Adds a label at the click point, enabling the user to enter and select a label text and label 
icon type.

Remember label and publish to all users: When this option is checked, the new label is added to the 
database. Whenever the place is selected, all the customized labels are available for selection by the user. 
When the option is unchecked, the modified label is used only by the current map.

 Streets: Enables the user to select and label streets on the map. Street data must be loaded for this 
feature to work (see Extra Data Tab).

Note: Rotation of labels in WME does not effect label objects generated by Viz (3D labels). The rotation is 
noticed only when using labels as part of the map texture.
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Add Shape: Adds shapes to the map. Select between points (straight) and Bezier (curved). Selecting the Add 
Shape button also opens a small toolbox for selecting shape designs.

Available options are:
Area: Fills the drawn shape, and also closes the line (see Closed Line).
Closed Line: Allows the user to close the shape without setting the final point (for example, two 
points draw a third closing the line with the first point).
Open Line: Allows the user to draw a line that is not closed.
Delete Last: Deletes the last drawn line.
Cancel: Cancels the draw operation.

Edit Shape: Allows the user to edit the shapes and streets added to the map. Streets (roads) can be offset, 
while shapes can be adjusted using the Point toolbox that appears when the Edit Shape button is selected.

Note: Shapes and streets can be edited further using the maps plug-ins (for example, 3D Line and 3D Line 
Manager).
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To Create a Map Using the Quick Map Location Browser

Click the More button’s Quick Map option in the WME.
Select or search for a country in the Country list. The map area fits to the selected country and the State/
Region list shows a list of available regions of the selected country. When a country is selected in the list, the 
Add to map and Mark Area buttons are enabled.
Select an entry from the list, the County/sub region list are filled.
Click Finish to close the location browser and create the map.

Tip: Clicking the Search button switches the Quick Map tool to the search tool mode.
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To Set the Map Location

Click the Set Location button in the WME to open the Set Location dialog box.
Enter the longitude, latitude, and map size radius in miles, kilometers, meters or yards.
Click OK to calculate and display the map in the Map Area.

To Pick a Label and Add It to the Map

Perform a search and select a location.
Click the Pick Feature button to display all the phantom labels for the selected area.
Click a label to add it to the map.
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To Move a Label

Click the drop-down button to open a list of options.
Select one of the options and then select a label on the map and move the label around in the graphic 
display.

9.3.8 Map Details Area

The Map Details area displays a list of all the added locations over the map. The user can modify the map, by 
selecting one of the added places and the control buttons on the right side of the map details area.

Map Details Parameters

Style: Sets or modifies the graphic display representing the selected place on the map. The style selection 
affects the highlighting color used to mark the selected place, the label, and so on.
Font Size: Sets the font size used for the label in the graphic display. Font size is only relevant for the display 
in the editor and for text labels that are exported as part of the map texture; hence, it does not affect the size 
of labels rendered by Viz.
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All Caps: Uses only capital letters in the graphic display when showing the selected place’s label.

 Rename label button: Opens the Rename Label dialog box that allows the user to customize and add 
other labels to the database by entering a new label for the selected place or by selecting an existing label 
from the list of labels or modifying an existing label.

Remember change and publish to all users: Adds the renamed label to the database when this 
option is checked. Whenever the place is selected, all the customized labels are available for 
selection by the user. When the option is unchecked, the modified label is used only by the current 
map.

 Delete place from map: Removes the selected entry from the map (and from the map details list).

 Delete all places from map: Removes all added places from the map (and from the map details list).

Note: The label is used in the graphic display and in the map details area.
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9.4 Using the Map Editor
This section describes how to use Viz World’s Map Editor (WME) with Viz Artist, Viz Pilot client (which includes how 
to use Viz Template Wizard and the Newsroom Component), and Viz Trio.

This section contains information on the following topics:

To Test with Viz Artist
To Test with Viz Pilot
To Test with Viz Trio

9.4.1 To Test with Viz Artist

Viz Artist requires no additional setup as long as the Viz World Client is installed, and the map server settings in Viz 
Config’s Maps section have been activated.

Open a map scene.
Locate and click the CWMClient icon in the tree structure to open the CWMClient Editor.
In the editor, click the Viz World Map Editor (WME) button to open the editor.
Search and select a map, and click OK to add a map to the scene.

Note: Make sure that ControlMap plug-ins are placed on the same containers as the CWMClient plug-ins 
for Viz Pilot to be able to change their maps.
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9.4.2 To Test with Viz Pilot

Viz Pilot’s map server parameters are stored on the Viz Pilot database. The parameters can be set or changed using 
the Viz Pilot client (Options > Preferences > Viz World).

For an operator or journalist to be able to change maps, the map scenes must use the ControlMap plug-in. Also, 
before the scene can be used in the Viz Pilot client or Newsroom Component a map template must be created using 
Viz Template Wizard.

Start Viz Template Wizard.
Import a Viz Artist map scene to the Viz Template Wizard. If a ControlMap plug-in is used by the designer, an 
image component is automatically added to the template. A template user clicking the image component is 
then able to open Map Editor to select a map.
The ImageSources property should be set to IsAdvancedCuriousMap.
Save the template to a concept.

Once the template is stored it can be opened by the Viz Pilot client or Newsroom Component.
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Start the Viz Pilot client or Newsroom Component, and open the newly created template.
Click the image in the template to open the WME.
Enter a search criteria (for example London).
Select London City, England from the list.
Tick London City, England, and click the zoom button (map icon) for England.
Click OK to close the WME.
Save a data element of the template and add it to the playlist.
Play or preview the scene on a local Viz Engine renderer to see the map animations.
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9.4.3 To Test with Viz Trio

Viz Trio’s map server parameters are set by the local Viz Engine that Viz Trio uses to render the scenes locally; 
hence, there is no need to configure Viz Trio.

Start Viz Trio.
Select Import Scenes from the drop-list in the Editing window.
Locate and import a tutorial scene to create it as a Viz Trio template.
Select and double-click to open the newly added template.
Click the Browse Viz World button to open the editor.
Enter a search criteria (for example London).
Select London City, England from the list.
Tick London City, England, and click the zoom button (map icon) for England.
Play the scene in Viz Trio so see the map animations.
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10 Photoshop Plug-in
The Viz World Photoshop plug-in is used to integrate Viz World and Adobe Photoshop files. Maps created with the 
Photoshop plug-in creates a new file with separate layers for every feature and detail on the map.

This section contains the following topics:

Working with the Photoshop Plug-in
Photoshop Layers
Viz World Settings in Photoshop

10.1 Working with the Photoshop Plug-in
Once the plug-in is installed, you are able to open Map Editor Classic from within Photoshop.

In Photoshop, go to File > Scripts and you see the Viz World options.

Note: The Photoshop plug-in must be installed separately, see Installing Photoshop Plug-in.
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The options that the plug-in adds, are:

Viz World Map Editor
Opens Map Editor Classic.
Select a TPL, style, and so on, then browse and add details to your map.
After making your selections and clicking OK, a new Photoshop file is created with all the layers of the 
different features and details on the selected map.

Viz World Refresh Map
Opens Map Editor Classic with the selections and map from the previously generated Photoshop file.
Modify your selection, add details to the map, and so on.
After making your selections and modifications and clicking OK the changes are applied to the 
existing Photoshop file instead of creating a new file.

Viz World Save As Geotiff: Save the file as a GeoTIFF file (a TIFF file which includes georeferencing 
information).
Viz World Setting: Opens the settings window.

10.2 Photoshop Layers
The Photoshop plug-in creates five layers in your Photoshop file. The following two layers are always created:

All Layers (a raster image of the final selected map).
Base Map (a raster image of the land and sea without any selections).

The remaining three layers can be configured in the Viz World Settings in Photoshop window.
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10.3 Viz World Settings in Photoshop
To open the Viz World Settings, go to File > Scripts > Viz World Setting.

Server Name: Viz World Server Host name.
Layer 1/2/3: The Photoshop plug-in creates five Photoshop Layers. Three of these layers can be configured 
here by selecting the features that should be included.
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11 Geographically Referenced Maps

The CWMClient plug-in produces geographical maps (GeoMaps). Geo maps are images of maps that are 
geographically referenced (that is the image contains information about its longitude and latitude).

Geo maps are identified by a little globe icon next to the image icon. Containers that are placed under the GeoMap 
container using geographic data referencing are placed relatively on the GeoMap.

The GeoMap can be placed on any Geometry Object; however, the geographical referencing will be incorrect when 
placed on 3D objects other than Globe. It is recommended, for best geographical referencing results, to use 
GeoImage, Globe or terrain objects.

Warning: Do not modify the image properties. All modifications should be done in the container 
properties editor. Changing the scale, rotation or position of the image in the image editor results in loss of 
the image’s geographical reference.
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12 Viz World Plug-in API
The Viz World Plug-in API offers an easy to use geo-reference capability when building your own Viz Artist plug-ins. 
The API allows you to communicate and manipulate Viz World scenes and get Navigator Plug-in information.

12.1 Working with the API
This section contains short descriptions on how to use the API and what it does.

12.1.1 VWPosition
Can be used to position a container based on a longitude/latitude coordinate on a geo-referenced map.

To Use VWPosition
Add a geo-referenced map on a container (using GeoImage/Globe geometry).
Add a child container to the newly created container with a geometry and the VWPosition plug-in.
Changing the longitude/latitude updates the position of the new container.

12.1.2 VWMousePosition
Can be used to translate a Mouse position into a longitude/latitude coordinate.

To Use VWMousePosition 
Add a geo-referenced map on a container (using GeoImage/Globe geometry).
Add a child container to the newly created container with a geometry and VWMousePosition plug-in.
Click the E button (events button next to the Scene Editor).
Click on the map and see that the new container moves to the coordinate.

12.1.3 VWNavigatorControl
Can be used to get or set Navigator values.

To Use VWNavigatorControl 
Create a Navigator scene.
Under the scene’s GeoReferenceMap container, add a new container with a VWNavigatorControl.
Clicking the Update Geo Ref Data button reads navigator current values.
Changing one of the fields sets Navigator values.
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12.2 Best Practices
When using a geo-reference (VWGeoref) object it is best to use a class member that is initialized in the constructor or 
only when you would like to explicitly do a refresh, doing so on the ExePerField impacts performance.

The scene object (VWScene) has to be initialized in the constructor and has to be freed on the destructor, avoiding 
to do so results in a performance impact as Viz World’s memory consumption is not freed.

12.2.1 Example

class MyPlugin { 
.... 
private: VWScene * m_pVWScene; 
}
 
MyPlugin::MyPlugin() { m_pVWScene = VWScene::AddVWSceneInstance(this); } 
MyPlugin::~MyPlugin() { VWScene::RemoveVWSceneInstance(m_pVWScene, this); }
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13 Viz World Server REST Support
This section contains a list of searches and functionalities of Viz World Server that can be accessed with a 
Representational State Transfer (REST) architecture using the atom protocol.

The Viz World Server has the following entry point: http://<vizworldserver>:10301/Directory

This section contains information on the following topics:

Browsing Regions
Browsing Projects and Favorite Folders
OpenSearch Support
Place Finder Server
Specify a Bounding Box
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13.1 Browsing Regions
Viz World Server allows browsing regions (for example, administration levels country, admin1, admin2) by returning 
a feed that represents each region and contains entries for each sub-region (or if none, entries representing towns 
in that region).

Each entry contains an atom description of the region, a link to its feed, links to towns contained in that region, a 
link to a map of the region (using the Place Finder functionality shown later) and an XML representation that is used 
by the Viz World clients.

13.1.1 URLs
http://<vizworldserver>:10301/Browse  is the main URL that returns a feed of all countries.

http://<vizworldserver>:10301/Browse?id=91296a0a00000600  is an example region URL
that returns a feed containing an entry for each sub-region of the queried region. If no sub-regions exist, a 
list of towns in that region are returned.

13.1.2 Parameters
The following describes the main fields (XML tags) of each entry:

ID: Viz World database unique ID of the region/town.
Title: Viz World database name of the region/town.
Summary: HTTP text containing feature details - thumbnail, feature type, name, link to map (using Place 
Finder URL), link to major/minor/both towns of the region (if exists).
Content: Contains an XML representation of the feature, containing information like long/lat, full region 
description (Paris France for Paris), feature type and more information that the querying application might 
need.
Link (down): Contains the same link as the link (alternate). Required by Viz Feed Browser.

The summary (depicted above) is displayed in browsers like this (circled in red). For more details, see the 
XML Example below.
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13.1.3 Example

<entry>
<id>1000000000001200</id>
<title type="text">Belgium</title>
<summary type="html">&lt;table&gt;&lt;tr&gt;&lt;td&gt;
&lt;img src="http://<vizworldserver>:10301/FeatureThumbnail/?feature=Country"&gt;&lt;
/td&gt;&lt;td&gt;Country&lt;br&gt;&lt;a href="http://<vizworldserver>:10301/
PlaceFinder/?Search=(null)"&gt;Get Image&lt;/a&gt;&lt;br&gt;See Towns:&lt;a href="htt
p://<vizworldserver>:10301/Browse/?id=71f2d1c100001200&amp;filter=Capital,Town 
1m,Town 100k"&gt;13 Major Towns&lt;/a&gt;&lt;/td&gt;&lt;/tr&gt;&lt;/table&gt;</
summary>
<updated>2010-07-07T15:22:39Z</updated>
<author><name>VizWorldServer</name></author>
<thumbnail url="http://<vizworldserver>:10301/FeatureThumbnail/?feature=Country"/>
<link rel="up" type="application/atom+xml;type=feed" href="http://
<vizworldserver>:10301/Browse/"/>
<link rel="self" type="application/atom+xml;type=entry" href="http://
<vizworldserver>:10301/PlaceFinder/?Search=Belgium"/>
<link rel="alternate" type="application/atom+xml;type=feed" href="http://
<vizworldserver>:10301/Browse/?id=71f2d1b900001200"/>
<link rel="down" type="application/atom+xml;type=feed" href="http://
<vizworldserver>:10301/Browse/?id=71f2d1b900001200"/>
<content type="application/atom+xml;type=feed">
  <MapFeature>
  <FeatureID>1000000000001200</FeatureID>
  <Name>Belgium</Name>
  <DBName>Belgium</DBName>
  <AlterName>Belgium</AlterName>
  <Type>Country</Type>
  <GeoPoint>4.466875, 50.259453</GeoPoint>
  <Diameter>280.409729</Diameter>
  <FullDesc>Belgium</FullDesc>
  </MapFeature>
</content>
</entry>
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13.2 Browsing Projects and Favorite Folders
Viz World Server allows browsing the folders of projects (*.tpl files) and favorites (*.cxp files) that are stored in the 
browser. A folder feed contains an entry for each sub-folder and project/favorite contained in the folder.

A project feed contains an entry for each stylesheet contained in the browser. A favorite link and project-style link 
returns an image of the favorite/style.

13.2.1 URLs

http://<vizworldserver>:10301/ProjectsFolder/ 
http://<vizworldserver>:10301/FavoritesFolder/

Each favorite/project/style entry also contains a thumbnail tag that contains a URL of a thumbnail image of the 
project/favorite/style for use by Viz Feed Browser. The thumbnail URL is also included in the summary of the entry, 
for use by browsers.
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13.3 OpenSearch Support
Viz World Server supports using OpenSearch to search features in the server database, plug-ins and web.

13.3.1 URLs
OpenSearchDescription URL: 
http://<vizworldserver>:10301/OpenSearchDescription

OpenSearch template:
http://<vizworldserver>:10301/OpenSearch?q={searchTerms}&pw={startPage?}

&visible={viz:visible?}&filter={viz:filter?}&source={Internal/All/MapDB/

ExtraData/Web}

Example URLs:

http://<vizworldserver>:10301/OpenSearch?q=Paris&filter=Capital&source=MapDB 
http://<vizworldserver>:10301/OpenSearch?q=Salem&filter=Town 10k
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13.4 Place Finder Server
Viz World Server allows receiving maps of locations/features, in the same way as the Place Finder plug-in. This can 
be used by Escenic or any other web application, or for demonstrations of Viz World.

13.4.1 Example URLs

http://<vizworldserver>:10301/PlaceFinder/?
Longitude=40.0&Latitude=40.0&FrameMapBy=Country&AddRegions=Full 
http://<vizworldserver>:10301/PlaceFinder/?
Search=USA&MapWidth=1000&MapHeight=500&AddSearchLabel=1

13.4.2 Parameters
Most parameters are taken from the configuration server (and stored in registry). Upon first use (or if missing in 
registry) the default values below are used. For parameters that are not stored in the registry, use the default values 
below.

ProjectName: Desired project (default is VizDefProject.tpl).
Style: Desired stylesheet.
MapWidth: Sets the width of the map (default is 512 ).

MapHeight: Sets the height of the map (default is 512 ).

Longitude, Latitude: Defines the center of the map if Search is empty (default is 0.0,  0.0 ).
Search: Desired feature name.
AddSearchLabel: Adds the found label to the map, if search is used.
DefaultMapSizeDeg: Determines the size of map to be retrieved in degrees (used when FramMapBy = 
DefaultMapSize).
FrameMapBy: Can be DefaultMapSize, Country, Admin1, Admin2 or Search.
PlaceText: Adds text label to map (if not empty).
FullDescription: Displays full-description feature labels (Paris France for Paris).
AddRegions: Can be Disabled, FrameOnly, FrameAndBelow or Full.
ReturnImage: 1  for image (default), 0  for representing XML.



Viz World User Guide -  24.0

Copyright © 2025  Vizrt                                                          Page  139

•
•
•

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

•

13.5 Specify a Bounding Box
With this feature, users can use the rest API to return map features within a specific bounding box.

13.5.1 URL

Base URI

http://<vizworldserver>:10301/Browse?" class="external-link">http://

<vizworldserver>:10301/Browse?

URL Template

http://<vizworldserver>:10301/Browse?left={value}&right={value}&bottom={value}

&top={value}&filter={FilterTerms}&maxAnswers={value}

Parameters

Bounding box values:
left, right, bottom, top, or
west, east, south, north

Filter:
all
Capital
Town 1m
Town 100k
Town 10k
Town 1k
Town
Tourist Attraction
Reserve Or Park
Region Name
Physical Area Name
Physical Water Name
River Name
Mountain Name
Region Capital

MaxAnswers: (optional) default 500
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13.5.2 Examples

http://<vizworldserver>:10301/Browse?left=0&right=0.5&bottom=51&top=51.5&filter=Town 
10k,Town 1k 
http://<vizworldserver>:10301/Browse?left=0&right=0.5&bottom=51&top=51.5&filter=all 
http://<vizworldserver>:10301/Browse?
left=-2&right=1.5&bottom=51&top=55.5&filter=River Name 
http://<vizworldserver>:10301/Browse?left=0&right=0.5&bottom=51&top=51.5&filter=Town 
10k,Town 1k&maxAnswers=50
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14 Viz World Classic

This chapter introduces Viz World Classic (VWC) which is the classic design tool for map templates used by the Viz 
World Client (WoC) and Vizrt control applications. Viz World Classic is an alternative to Viz World Client’s Map 
Designer.

Viz World Classic is a design tool with a database back-end, used for the creation of branded maps. By extending it 
with a server, it can provide real-time, branded map imagery to several clients embedded within Vizrt control 
applications. Templates created using Viz World Classic or the Map Designer can be dynamically accessed through 
Vizrt control applications using the WoC.

Viz World Classic has access to a comprehensive vector based database that includes regions, cities, roads, rivers, 
and so on. The vector data is supplied to Vizrt under license from Bartholomew Mapping (a division of Harper 
Collins publishers). VWC also includes global 1km relief data in the DEM (Digital Elevation Model) format. The DEM 
data is provided by the United States Geological Survey (USGS). Essentially, VWC uses the best mapping data 
available and is a full animation and compositing system.

This section contains information on the following topics:

Project Templates
Styles Editor
Markers
Map Position and Project Area Offset
Layer Stack and No Animation
Map Projection

See Also

Map Designer

Note: This chapter does not cover all aspects of map design using Viz World Classic; however, this chapter 
explains the important elements to note when creating a basic map template using Viz World Classic.
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• Viz World Classic User Guide

http://docs.vizrt.com/viz-world
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14.1 Project Templates
It is good practice to place all template (TPL) files in a single static location. The recommended location is:

32-bit: C:\ProgramData\Curious Software\Curious World Maps\Users\Default\Projects
64-bit: C:\ProgramData\vizrt\Viz World\Users\Default\Projects

This folder and any sub-folders are automatically scanned for TPL files when the Map Server is launched.

14.1.1 To Open a Project Template
Select Open... (CTRL + O) from the File menu.
Select Project Template (*.tpl, *.tpt, *.cgt) from the Files of type drop-list.
Select the template file and click Open.

14.1.2 To Save a Project Template
Select Save (CTRL + S) from the File menu.
Select Project Template (.tpl) from the Save as type drop-list.
Enter a filename, and click Save.

Note: The template location should be exactly the same on Viz World Server and any Viz World Classic 
design systems. If the paths are not identical, it may break the link to any image elements (for example, 
Markers).
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14.2 Styles Editor

Using the Viz Curious Maps (CM) Styles Editor, users can choose to modify an existing default Style Sheet or create a 
new one.

The user has the ability to define and fully customize all of the available map data elements via the Curious Maps 
Styles Editor. For example, the user can set region colors, select any TrueType font, assign any static image (images 
with alpha are supported) as a marker, modify shadow settings, change relief scale and lots more!

The map Style Sheets defined within the CM Styles Editor are then saved as Project Templates (*.tpl files). Each 
Project Template can include any number of Style Sheets. These Project Templates can then be accessed via the Viz 
World Map Editor (WME) within other Vizrt products, such as Viz Artist, Viz Trio, Viz Pilot, and so on.
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14.3 Markers
Many users work with customized Markers. Image files can be imported to Viz World Classic (VWC) from any 
location. VWC creates a Relative or Absolute file path to the actual image file (depending on its distance from the 
TPL). If VWC cannot locate an image file, it replaces it with a missing material red X.

It is good practice to place all Markers in a single static location, as opposed to multiple folders on a local computer 
and/or network.

The default location is:

32-bit: C:\Program Files\Curious Software\Curious World Maps\Markers
64-bit: C:\Program Files\vizrt\Viz World\Markers

Note: When exporting a map related Viz Artist scene archive, it is important to also include the template 
(*.tpl) files and any referenced image files (used for Markers, and so on).
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14.4 Map Position and Project Area Offset
Within Viz World Classic (VWC) there are two sizes to be aware of, the Project Size and the Map Size. Both of these 
sizes have their own specific purpose and can have different values. If the sizes are different or if the Map Position 
does not match the Project Area exactly, the map does not look right when viewed in Viz Artist, Viz Trio, Viz Pilot, 
and so on. Even a minuscule offset breaks the map.

To avoid the issue entirely, you should delete the Map Layer and add a new one. This automatically adds a map that 
fits the current Project Size, but note that it uses the Globe projection and requires correction.

14.4.1 To Set the Project Size
Select Project Settings from the File menu.
In the Project Settings dialog box set the Width and Height parameters.
Click OK to confirm the new project settings.

14.4.2 To Set the Map Size
Select the Properties tab on the Properties panel.
Select the Transform options, and set the same Size (X and Y) that was used To Set the Project Size.
Press ENTER to confirm and update the map.

14.4.3 To Add a New Layer
Select Add Layer > Map from the Layer menu.

Example: The Map Rectangle Tool (on the vertical toolbar) allows the user to freely move the map around 
and can easily move the map out of position.
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14.5 Layer Stack and No Animation
To avoid problems with the template (*.tpl) file, it is good practice to ensure that only one layer is present in the 
Layer Stack. It is also important to remain at frame 1 in the timeline and refrain from adding any animation 
keyframes.
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14.6 Map Projection

An essential setting for 3D globe building in Viz Artist is To Set the Map Projection to an equidistant cylindrical 
projection (also known as equi-rectangular or geographic projection). When using the map on a 3D globe in Viz 
Artist, it gives a more correct representation of the world.

14.6.1 Distorted Projection

Note: In Viz Artist, vertex mapping should be used when creating 3D globes.
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Using the wrong projection within Viz Artist (for example, with the Map Tiler plug-in to build a 3D globe) produces a 
distorted projection.

14.6.2 To Set the Map Projection
Select the Properties tab.
From the Projection drop-list select the Cylindrical Equidistant projection.
Select The World from the View drop-list (lower-right corner) to check that the map is a flat and not a globe 
view of the World.
Click Apply.

Note: This test also works well via the World Map Editor in Viz Artist.
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15 Frequently Asked Questions
This section contains some of the frequently asked questions concerning the use of Viz World Client and Server.

I can connect Client A to the map server, Client B is able to ping the map server, but Client B still has no 
connection to the map server. What is wrong?

Sometimes, a machine is not accessible to all other computers in the network by its hostname.
For example, if there are two clients, Client A & Client B, and the Viz World Server and the Server Allocator 
running on the MapServer machine, Client A might resolve MapServer to the IP 192.168.1.100, but Client B 
might not resolve it to the same IP, or might not resolve it at all because ClientB is on another subnet or for 
any other given reason.
Both clients can access the MapServer if it was defined as 192.168.1.100 or MapServer.company.domain.
A frequent problem is therefore that users might write in Client B’s Viz Config the IP 192.168.1.100, and in 
Client A’s Viz Config MapServer (because that is the address each can resolve); however, this results in that 
the Server Allocator returning to both clients the same hostname that was specified in the Server Launcher 
Configuration tool and therefore only accessible to ClientA.
In other words, in the field of ControlledMapServer, the hostname/IP that is specified has to be known to all 
clients and the Server Allocator machine.

I have problems loading my map scenes in Viz Trio?

Map scenes often use a large amount of texture memory; hence, this takes time to load and may cause Viz 
Trio’s local preview channel to time out.
In Viz Trio it is possible to adjust the Viz Engine Connection Timeout for the local preview channel.
Click the Config button, and under the Miscellaneous section select Local Viz Renderer, and set the Viz Engine 
Connection Timeout parameter.

What are the Digital Globe proxy and firewall configuration settings?

If you need to use a proxy, remember to set your Proxy Server settings.
All communication to Digital Globe servers goes through HTTPS to securewatch.digitalglobe.com.
See also Digital Globe cache settings.

What are the Microsoft Bing Maps proxy and firewall configuration settings?

If you need to use a proxy, remember to set your Proxy Server settings.
All communication to Microsoft Bing Maps servers goes through HTTP (SOAP and regular HTTP GET) on port 
80 .

Any sub-domain of virtualearth.net should be accessible to the Viz World Server and Viz World Classic 
application. For example: dev.virtualearth.net, t1.tiles.virtualearth.net, t3.tiles.virtualearth.net, etc.
See also Bing cache settings.

The server cannot find the dongle

Run as administrator. Make sure you are not using Windows Remote Desktop. Instead, you can use Remote 
VNC or Team View.

Are orthographic cameras supported?

Note: There is no such setting for the Viz Pilot client as the Viz Pilot client itself does host the Viz process 
for local preview.
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• Orthographic cameras are not currently supported by Viz World.
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16 Server Operation
This section describes how to start Viz World Server (WoS) and how to use the Server Launcher to start, stop and 
configure the WoS and Server Allocator.

This section contains information on the following topics:

Starting Viz World Server
Server Launcher
Using Server Launcher
Server Launcher Configuration
Server Allocator Configuration

16.1 Starting Viz World Server

16.1.1 To Start the Server
Double-click the desktop shortcut, or Select the program from the Start menu: All Programs > Vizrt > Viz World 
Server.

A console window appears that loads the database. When done, the server is ready to receive requests from clients.

16.2 Server Launcher

Viz World Server Launcher is a tool used to start, stop and configure the Viz World Server and Server Allocator. In 
addition, it also starts a process that generates thumbnails of map templates used by the Viz World Client’s Map 
Designer tool.

16.3 Using Server Launcher
The Server Launcher is an application installed as part of the Viz World Server, and can be found on the programs 
menu. The Server Launcher is run as a service by default.

When the Server Launcher is configured, the Server Allocator distributes client requests between the registered 
servers and server machines, balancing server loads and the number of client requests. When configured in a 
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complex environment, multiple map servers with multiple Server Allocators can be used to allow full redundancy 
and optimal resource distribution.

Starting a single instance of the maps server can be done from the program menu or by using the desktop icon.

Starting the Server Allocator, in order to setup a redundant system and/or configure more than one instance of the 
map server on one server, is done using the Server Launcher.

When the Server Launcher is running, it typically floats on top of the desktop, but it can be minimized to the tray.

16.3.1 Desktop Icon

 The status of the Server Launcher is indicated by the color of the icon:

Icon Color LED Color Meaning

Normal icon Green LED Licensed, running

Normal icon Grey LED Licensed, not running

Greyed icon Green LED Not Licensed, running (this only applies to Service 
Allocator, since it is not licensed)

Greyed icon Grey LED Not Licensed, not running

16.3.2 Tray Icon
The tray icon allows you to minimize the application to the tray and restore it.

Restore / Minimize To Tray: Restores or minimizes the Server Launcher from or to tray.
Start / Stop Server: Starts and Stops the Server Allocators and the Viz World Server without exiting the 
Server Launcher application.
Options: Opens the Options window for configuring the number of Viz World servers and Server Allocators. 
See Server Launcher Configuration for more information.
Exit Launcher: Closes the Server Launcher application. Server Allocator and Viz World server are still 
running.
Exit & Shutdown (Not Recommended): Closes the Server Launcher application. Stops all Server Allocator 
services and the Viz World server.
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16.4 Server Launcher Configuration

Viz World Server is configured using the Server Launcher.

Click the Server Launcher’s Options button in order to configure the map server.

Preferences: Allows the user to set the local server count and enable the Server Allocator.
Local Server Count: Defines the number of server instances that run on the machine simultaneously. 
Default value is 1 . When setting the number of instances for each machine, machine hardware 
should be considered. Every server instance requires physical memory (RAM) and makes intense use 
of the CPU. Do not abuse this parameter, since client and server performance are affected.
Enable Priority Login: Enables Viz World Server to prioritize its inbound client connections. Viz’ 
configuration interface allows you to prioritize client connections from Viz Artist and On Air Viz 
Engines used for preview and program output. Viz Engines must be in On Air mode for them to be 
prioritized. For the Map Editor, you can set it from the Context Menu. For more information on how to 
set priorities see the Maps Configuration section.
Run Server Allocator: When disabled (not selected), the Server Allocator do not run on the machine. 
When enabled (selected), the Server Allocator runs and uses the parameters defined in the Server 
Launcher’s Options window. Default mode is disabled. Server Allocator does not require any license 
and can be run on any machine.

Launch Options: Allows the user to run Viz World Server and the Server Launcher as a service, or in console 
mode. If run as a service, the system can automatically start all server instances when the machine starts 
without the need to login. If run in console mode, all instances must be manually started.

Important! If the Server Allocator is enabled, even for just one machine, the machine must be defined in 
the Controlled WoS list.
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Controlled WoS: When enabled (see Run Server Allocator), the Controlled WoS settings allows the user to 
configure the controlled WoS instances.

Machine: Sets the name of a machine running Viz World Server.
Count: Sets the number of instances running on the machine. Default is 1 .
Priority: Sets the machine’s priority. If more than one machine is defined, the priority must be set for 
each machine.
Instances: Sets the number of instances that are controlled by the machine. If the machine has more 
than one instance running, it is possible to open the Instance Control (click Set) To Set the Controlled 
Instances.

16.4.1 Setting Priorities
Normally all servers use the same priority (1). In more complex scenarios a lower priority can be used, for example 
when two servers are running two instances each and an allocator.

One server is typically dedicated to an On Air Engine and another to a Viz Artist (designer) client such that a designer 
client does not steal a token from an On Air Engine.

Example setup:

Map server A is for the On Air Engine and it controls two instances on map server A with priority 1, and two 
instances on map server B with priority 2.
Map server B is for the Viz Artist designer and it controls two instances on map server B with priority 1, and 
two instances on map server A with priority 2.
The Server Allocator does not redirect any clients with map server A as default to map server B if it can give 
them an instance on map server A because map server B has a lower priority. So, only if the instances on A 
are out of license tokens, or not responding, the Server Allocator directs clients to map server B. And the 
same for B.

Another example is in a scenario where there are two allocators (one in Location 1 and another in Location 2), all 
clients from Location 1 should be connected to the server in Location 1, and all clients from Location 2 should be 
connected to the server in Location 2, and only if anything goes wrong should clients be allowed to connect from 
Location 1 to Location 2.

16.4.2 To Add or Remove Instances
Click the + or - buttons in the Options window to add or remove instances.

Note: When the Server Allocator allocates a server to a client, it passes this name to the client, hence, its 
hostname/IP address must be accessible to all clients.
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16.4.3 To Set the Controlled Instances

Click the Set button in the Server Launcher’s Options window.
Double-click the instance to set the control mode to Controlled or Not Controlled.
Click OK.

16.5 Server Allocator Configuration
Optimal usage of system resources can be obtained by using multiple map servers, running multiple map servers on 
each machine, with a Server Launcher launched on each of the machines.

The system can be configured with:

One allocator for multiple map servers,
One allocator on one machine with multiple servers.
Multiple allocators with multiple server machines.

16.5.1 Single Server Allocator Configuration
The simple environment setup is when running one map server with multiple map server instances and a Server 
Operation. In this configuration, the Server Allocator accepts client requests and diverts them to the server 
instances on the same machine. Client connections are equally divided between the map server instances, allowing 
better response time and load balancing of server processes.

16.5.2 Multiple Server Allocator Configuration: Classic Redundancy
Having multiple servers, where in each there is a Server Allocator running that controls all WoS instances of all 
machines.

This configuration guarantees most redundancy as each Server Allocator is updated with the current status of all 
WoS servers, and in case of a failure in one of the machines, other Server Allocators can provide redirection to any 
available WoS.

Note: The number of controlled instances is displayed in the Instances field and column seen in the 
Options window.
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The maximum number of server instances that can be run per machine is four. Each server instance should have 4 
GB of memory and two CPUs. So on a machine with four dual CPUs and 16 GB of memory, you can run the 
maximum of four server instances.

The above diagram describes a system with two machines running a Server Allocator and four map server instances 
on each machine. If the client is configured with both machine names, full redundancy within the system is 
accomplished.

See Also

Server System Requirements

Note: Any configuration combination between the Server Allocators and the map server instances is valid.
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17 Downloading Extra Map Data
This section includes information on the following topics:

Available Data
Download Extra Maps Data
Use the Data

Rescan Routine
Licensing

OSM Downloader Deprecation Notice

17.1 Available Data
Available extra maps data for download:

Street Data from Open Street Maps (OSM).

17.2 Download Extra Maps Data
Open Vizrt FTP through:

Browser: https://download.vizrt.com
FTP Client: ftp://download.vizrt.com

Log in with your Vizrt FTP Credentials.

Go to Products > vizstreetdata > OSM for open street maps.
Select the desired Data packages, then click Download

17.3 Use the Data
The downloaded StreetData (OSM Maps) files are located in C:\ProgramData\Vizrt\Viz World\MapData\StreetData.

17.3.1 Rescan Routine
Open VizWorld Server Configuration Tool.
Connect to the VizWorld Server.
Navigate to Maps > Street Admin.
Click on rescan/restart server.
Verify the required regions are displayed in the tree.
Close the Configuration Tool and the data is ready to be used.

Information: For information about Vizrt FTP account sign-up, please contact your local Vizrt 
representative.

Note: It is recommended to use an FTP client for bulk or directories downloads. 

https://download.vizrt.com/
ftp://download.vizrt.com/
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17.3.2 Licensing
A specific license may be required depending on the files downloaded; to obtain the required license to use street 
data on Viz World, please contact your local Vizrt representative.

For example, in order to be used in Viz World, the 2019 edition of Norwegian street data requires a CDataOSMWORLD 
NORWAY license with version 19.03.

17.4 OSM Downloader Deprecation Notice
The OSM downloader tool is no longer supported after Viz World version 21.0, thus it is no longer included. 
Following the instructions on this page is the preferred way for downloading OSM data.

Navigate to Maps > Street Admin > files tree > file on Viz World Server Configuration Tool. The required 
license text and whether it was found are displayed at the bottom of the window.
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18 Third-Party Licenses
The following is a list of third-party libraries used in this software, along with their respective versions and 
associated copyright information. Due to the nature of the Viz World software some third-party libraries cannot be 
updated to latest versions. It is essential that customers carefully review these libraries for current and ongoing 
compliance with their own internal policies, security standards, and legal requirements prior to gaining access and 
while in use.

Library Version Copyright

After Effects SDK 12.10 After Effects SDK

Bonjour 107 Bonjour

libCurl 8.10.1 libCurl

GDAL 1.1.1, 2.0.35, 3.0.4 GDAL

HFA 1.7 HFA

libexpat 2.1.0 libexpat

libTIFF 3.8.2, 4.0.2 libTIFF

libJPEG 6.2 libJPEG

libkml 1.2 libkml

libpng 1.5.12 libpng

minizip 1.01e minizip

libshp 1.2.10 libshp

uriparser 0.7.5 uriparser

zlib 1.1.3 zlib

libcsv 3.0.3 libcsv

spdlog 1.6 spdlog

boost 1.73.0 boost
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Library Version Copyright

RapidJSON 1.1.0 RapidJSON

Proj 4.8.0 Proj

18.1 After Effects SDK

18.1.1 Version 12.10
Copyright © 1992-2024 Adobe Systems Incorporated and its licensors. All rights reserved.

Adobe, the Adobe logo, and After Effects are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries.

Portions utilize Microsoft Windows Media Technologies. Copyright © 2006 Microsoft Corporation. All Rights 
Reserved.

ASIO Technology by Steinberg Media Technologies GmbH.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-
identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other 
Pantone, Inc. trademarks are the property of Pantone, Inc. © Pantone, Inc., 2014. Pantone, Inc. is the copyright 
owner of color data and/or software which are licensed to Adobe Systems Incorporated to distribute for use only in 
combination with Adobe After Effects. PANTONE Color Data and/or Software shall not be copied onto another disk 
or into memory unless as part of the execution of Adobe After Effects.

TOYO COLOR FINDER® SYSTEM AND SOFTWARE ©TOYO INK MFG. CO., LTD. 1991-1994.

Color-database derived from Sample Books © Dainippon Ink and Chemicals, Inc., licensed to Adobe Systems 
Incorporated.

Portions of After Effects CC Copyright 2012, Avid Technology, Inc.

18.2 Bonjour

18.2.1 Version 107
Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following co
nditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaim
er.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following discl
aimer in the documentation and/or other materials provided with the distribution.
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3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to 
endorse or promote pr
oducts derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

18.3 libCurl

18.3.1 Version 8.10.1
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1996 - 2025, Daniel Stenberg, daniel@haxx.se, and many contributors, see the THANKS file.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, 
provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS 
IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to 
promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

18.4 GDAL

18.4.1 Version 1.1.1, 2.0.35, 3.0.4
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software.

mailto:daniel@haxx.se
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT 
OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

18.5 HFA

18.5.1 Version 1.7
Copyright (c) 1999, Intergraph Corporation

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation fi
les (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, 
modi
fy, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software
.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

18.6 libexpat

18.6.1 Version 2.1.0
Copyright (c) 1998-2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright (c) 2001-2025 Expat maintainers

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

18.7 libTIFF

18.7.1 Version 3.8.2, 4.0.2
Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby 
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in 
any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and 
Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA 
OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, 
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

18.8 libJPEG

18.8.1 Version 6.2
The authors make NO WARRANTY or representation, either express or implied,
with respect to this software, its quality, accuracy, merchantability, or
fitness for a particular purpose. This software is provided "AS IS", and you,
its user, assume the entire risk as to its quality and accuracy.

This software is copyright (C) 1991-1998, Thomas G. Lane.
All Rights Reserved except as specified below.

Permission is hereby granted to use, copy, modify, and distribute this
software (or portions thereof) for any purpose, without fee, subject to these
conditions:
(1) If any part of the source code for this software is distributed, then this
README file must be included, with this copyright and no-warranty notice
unaltered; and any additions, deletions, or changes to the original files
must be clearly indicated in accompanying documentation.
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(2) If only executable code is distributed, then the accompanying
documentation must state that "this software is based in part on the work of
the Independent JPEG Group".
(3) Permission for use of this software is granted only if the user accepts
full responsibility for any undesirable consequences; the authors accept
NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code,
not just to the unmodified library. If you use our work, you ought to
acknowledge us.

Permission is NOT granted for the use of any IJG author's name or company name
in advertising or publicity relating to this software or products derived from
it. This software may be referred to only as "the Independent JPEG Group's
software".

We specifically permit and encourage the use of this software as the basis of
commercial products, provided that all warranty or liability claims are
assumed by the product vendor.

18.9 libkml

18.9.1 Version 1.2
Copyright 2010, Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.
Neither the name of Google Inc. nor the names of its contributors may be
used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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18.10 libpng

18.10.1 Version 1.5.12
The software is supplied "as is", without warranty of any kind,
express or implied, including, without limitation, the warranties
of merchantability, fitness for a particular purpose, title, and
non-infringement. In no event shall the Copyright owners, or
anyone distributing the software, be liable for any damages or
other liability, whether in contract, tort or otherwise, arising
from, out of, or in connection with the software, or the use or
other dealings in the software, even if advised of the possibility
of such damage.

Permission is hereby granted to use, copy, modify, and distribute
this software, or portions hereof, for any purpose, without fee,
subject to the following restrictions:

The origin of this software must not be misrepresented; you
must not claim that you wrote the original software. If you
use this software in a product, an acknowledgment in the product
documentation would be appreciated, but is not required.
Altered source versions must be plainly marked as such, and must
not be misrepresented as being the original software.
This Copyright notice may not be removed or altered from any
source or altered source distribution.

18.11 minizip

18.11.1 Version 1.01e
Using zlib licnse as code is from /contrib

(C) 1995-2024 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.
Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.
This notice may not be removed or altered from any source distribution.
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Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

18.12 libshp

18.12.1 Version 1.2.10
Copyright (c) 2011-2024, Even Rouault
Copyright (c) 1999-2013, Frank Warmerdam

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

18.13 uriparser

18.13.1 Version 0.7.5
uriparser - RFC 3986 URI parsing library

Copyright (C) 2007, Weijia Song songweijia@gmail.com
Copyright (C) 2007, Sebastian Pipping sebastian@pipping.org
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions  of  source  code   must  retain  the  above
   copyright notice, this list  of conditions and the following
   disclaimer.
2. Redistributions  in binary  form  must  reproduce the  above
   copyright notice, this list  of conditions and the following

mailto:jloup@gzip.org
mailto:madler@alumni.caltech.edu
mailto:songweijia@gmail.com
mailto:sebastian@pipping.org
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   disclaimer  in  the  documentation  and/or  other  materials
   provided with the distribution.
3. Neither the  name of the  copyright holder nor the  names of
   its contributors may be used  to endorse or promote products
   derived from  this software  without specific  prior written
   permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

18.14 zlib

18.14.1 Version 1.1.3
(C) 1995-2024 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.
Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.
This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

mailto:jloup@gzip.org
mailto:madler@alumni.caltech.edu
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18.15 libcsv

18.15.1 Version 3.0.3

              GNU LESSER GENERAL PUBLIC LICENSE
                   Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

(This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.)

                        Preamble

The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
Licenses are intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about whether
this license or the ordinary General Public License is the better
strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and charge
for this service if you wish); that you receive source code or can get
it if you want it; that you can change the software and use pieces of
it in new free programs; and that you are informed that you can do
these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender these
rights. These restrictions translate to certain responsibilities for
you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we gave
you. You must make sure that they, too, receive or can get the source
code. If you link other code with the library, you must provide
complete object files to the recipients, so that they can relink them
with the library after making changes to the library and recompiling
it. And you must show them these terms so they know their rights.
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We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that
there is no warranty for the free library. Also, if the library is
modified by someone else and passed on, the recipients should know
that what they have is not the original version, so that the original
author's reputation will not be affected by problems that might be
introduced by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it becomes
a de-facto standard. To achieve this, non-free programs must be
allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
operating system, as well as its variant, the GNU/Linux operating
system.
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0.

1.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter must
be combined with the library in order to run.

              GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of
this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation
and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based
on the Library (independent of the use of the Library in a tool for
writing it). Whether that is true depends on what the Library does
and what the program that uses the Library does.

You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library.
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2.

3.

You may charge a fee for the physical act of transferring a copy,
and you may at your option offer warranty protection in exchange for a
fee.

You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no
charge to all third parties under the terms of this License.
d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses
the facility, other than as an argument passed when the facility
is invoked, then you must make a good faith effort to ensure that,
in the event an application does not supply such function or
table, the facility still operates, and performs whatever part of
its purpose remains meaningful.
(For example, a function in a library to compute square roots has
a purpose that is entirely well-defined independent of the
application.  Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must
be optional: if the application does not supply it, the square
root function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the Library
with the Library (or with a work based on the Library) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.

You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version 2,
instead of to this License. (If a newer version than version 2 of the
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4.

5.

6.

ordinary GNU General Public License has appeared, then you can specify
that version instead if you wish.) Do not make any other change in
these notices.

Once this change is made in a given copy, it is irreversible for
that copy, so the ordinary GNU General Public License applies to all
subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of
the Library into a program that is not a library.

You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange.

If distribution of object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the
source code from the same place satisfies the requirement to
distribute the source code, even though third parties are not
compelled to copy the source along with the object code.

A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled or
linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library
creates an executable that is a derivative of the Library (because it
contains portions of the Library), rather than a "work that uses the
library". The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file
that is part of the Library, the object code for the work may be a
derivative work of the Library even though the source code is not.
Whether this is true is especially significant if the work can be
linked without the Library, or if the work is itself a library. The
threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data
structure layouts and accessors, and small macros and small inline
functions (ten lines or less in length), then the use of the object
file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the
Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
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under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the
Library is used in it and that the Library and its use are covered by
this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the
copyright notice for the Library among them, as well as a reference
directing the user to the copy of this License. Also, you must do one
of these things:

a) Accompany the work with the complete corresponding
machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under
Sections 1 and 2 above); and, if the work is an executable linked
with the Library, with the complete machine-readable "work that
uses the Library", as object code and/or source code, so that the
user can modify the Library and then relink to produce a modified
executable containing the modified Library.  (It is understood
that the user who changes the contents of definitions files in the
Library will not necessarily be able to recompile the application
to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the
Library.  A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user's computer system,
rather than copying library functions into the executable, and (2)
will operate properly with a modified version of the library, if
the user installs one, as long as the modified version is
interface-compatible with the version that the work was made with.
c) Accompany the work with a written offer, valid for at
least three years, to give the same user the materials
specified in Subsection 6a, above, for a charge no more
than the cost of performing this distribution.
d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.
e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
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7.

8.

9.

10.

11.

use both them and the Library together in an executable that you
distribute.

You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined
library, provided that the separate distribution of the work based on
the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work
based on the Library, uncombined with any other library
facilities.  This must be distributed under the terms of the
Sections above.
b) Give prominent notice with the combined library of the fact
that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.

You may not copy, modify, sublicense, link with, or distribute
the Library except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense, link with, or
distribute the Library is void, and will automatically terminate your
rights under this License. However, parties who have received copies,
or rights, from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.
You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.
Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the Library
subject to these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties with
this License.
If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Library at all. For example, if a patent
license would not permit royalty-free redistribution of the Library by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Library.
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12.

13.

14.

15.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply,
and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License may add
an explicit geographical distribution limitation excluding those countries,
so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if
written in the body of this License.
The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time.
Such new versions will be similar in spirit to the present version,
but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published by
the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status
of all derivatives of our free software and of promoting the sharing
and reuse of software generally.

                  NO WARRANTY

BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
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16.

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

18.15.2 spdlog

18.15.3 Version 1.6
The MIT License (MIT)

Copyright (c) 2016 Gabi Melman.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

-- NOTE: Third party dependency used by this software --
This software depends on the fmt lib (MIT License),
and users must comply to its license: https://raw.githubusercontent.com/fmtlib/fmt/master/LICENSE

18.16 boost

18.16.1 Version 1.73.0
Boost Software License - Version 1.0 - August 17th, 2003

https://raw.githubusercontent.com/fmtlib/fmt/master/LICENSE
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Permission is hereby granted, free of charge, to any person or organization
obtaining a copy of the software and accompanying documentation covered by
this license (the "Software") to use, reproduce, display, distribute,
execute, and transmit the Software, and to prepare derivative works of the
Software, and to permit third-parties to whom the Software is furnished to
do so, all subject to the following:

The copyright notices in the Software and this entire statement, including
the above license grant, this restriction and the following disclaimer,
must be included in all copies of the Software, in whole or in part, and
all derivative works of the Software, unless such copies or derivative
works are solely in the form of machine-executable object code generated by
a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

18.17 RapidJSON

18.17.1 Version 1.1.0
Tencent is pleased to support the open source community by making RapidJSON available.

Copyright (C) 2015 THL A29 Limited, a Tencent company, and Milo Yip. All rights reserved.

If you have downloaded a copy of the RapidJSON binary from Tencent, please note that the RapidJSON binary is 
licensed under the MIT License.
If you have downloaded a copy of the RapidJSON source code from Tencent, please note that RapidJSON source 
code is licensed under the MIT License, except for the third-party components listed below which are subject to 
different license terms. Your integration of RapidJSON into your own projects may require compliance with the MIT 
License, as well as the other licenses applicable to the third-party components included within RapidJSON. To 
avoid the problematic JSON license in your own projects, it's sufficient to exclude the bin/jsonchecker/ directory, as 
it's the only code under the JSON license.
A copy of the MIT License is included in this file.

Other dependencies and licenses:

18.17.2 Open Source Software Licensed Under the BSD License
The msinttypes r29
Copyright (c) 2006-2013 Alexander Chemeris
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:
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•

•

•

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.
Neither the name of copyright holder nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS AND CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

18.17.3 Open Source Software Licensed Under the JSON License
http://json.org 
Copyright (c) 2002 http://JSON.org 
All Rights Reserved.

JSON_checker
Copyright (c) 2002 http://JSON.org 
All Rights Reserved.

18.17.4 Terms of the JSON License
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software.

The Software shall be used for Good, not Evil.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT 
OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

18.17.5 Terms of the MIT License
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following conditions:

http://json.org
http://JSON.org
http://JSON.org
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The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT 
OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

18.18 Proj

18.18.1 Version 4.8.0
Copyright (c) 2020 Dewey Dunnington (libproj) Copyright (c) 2000 Frank Warmerdam (PROJ sources)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the “Software”), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following conditions:/anchor

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT 
OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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